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Overview: BlackBerry Performance Engineering Resource
Kit

You can use the BlackBerry® Performance Engineering Resource Kit to test the behavior of a BlackBerry® Enterprise Server and
the BlackBerry Enterprise Server components under operating conditions that are typical for your organization. You can test a
new version of the BlackBerry Enterprise Server or changes that you made to an existing BlackBerry Enterprise Server before you
implementthe changes. You can change options in the BlackBerry Performance Engineering Resource Kitto change the operating
conditions of the test environment, including the amount of work or workload and the active signals that the BlackBerry Enterprise
Server receives.

You can use the BlackBerry Performance Engineering Resource Kit if your test environment includes a copy of the BlackBerry
Enterprise Server and the BlackBerry Configuration Database that you want to test.

The BlackBerry Performance Engineering Resource Kit includes the following components:

e TheBlackBerry Load Test Configuration Tool converts existing user accounts into a format that the BlackBerry Infrastructure
and Smartphone Simulator can use. You must use the BlackBerry Load Test Configuration Tool to convert BlackBerry
Enterprise Server user accounts before you run tests with the BlackBerry Enterprise Server.

e The BlackBerry Infrastructure and Smartphone Simulator simulates the actions of the BlackBerry® Infrastructure and the
BlackBerry devices. The BlackBerry Infrastructure and Smartphone Simulator sends all messages, including email messages,
records, and acknowledgements, to and from simulated BlackBerry devices through a simulated BlackBerry Infrastructure.
You do not require a BlackBerry Smartphone Simulator to use the BlackBerry Infrastructure and Smartphone Simulator in
a test environment.

You can use the BlackBerry Performance Engineering Resource Kit with the following versions of the BlackBerry Enterprise Server:

e BlackBerry® Enterprise Server 4.1.6 or later for Microsoft® Exchange

e BlackBerry® Enterprise Server 4.1.6 or later for IBM® Lotus® Domino®
e BlackBerry® Enterprise Server 4.1.6 or later for Novell® GroupWise®

e BlackBerry® Enterprise Server 4.1.6 or later for MDS Applications

The BlackBerry Performance Engineering Resource Kit is available to BlackBerry® Technical Support Services customers that
have a Tx4, Tx5, Premium Support, or Elite Support subscription.
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Requirements

System requirements: BlackBerry Performance Engineering Resource Kit

ltem Requirement
hardware on the computer hosting the BlackBerry Infrastructure and
Smartphone Simulator:
. Intel® Pentium® [1l 2.5 GHz (or higher) processor or its
equivalent
e 1GBRAM or more
e hard disk space for a 6 MB installation, 15 MB for each
day of logs stored, and additonal space that is sufficient
forany files that will be transferred using network access
license an unused BlackBerry® Client Access License
operating system any of the following operating systems:

e Windows Server® 2000 SP4
e Windows Server 2003 SP2
e Windows Server 2008
redistributable packages on each machine hosting a component of the BlackBerry®
Performance Engineering Resource Kit:

e Microsoft® Visual C++® 2005 C++ SP1 redistributable

package (x86)
e Microsoft® .NET Framework 2.0
virtual environment if you are using a virtual environment, one of the following:

e VMware® ESX® Server 3.0
e VMware ESX Server 3.5

Related topics
System requirements: Test environment for the BlackBerry Performance Engineering Resource Kit, 8
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System requirements: Test environment for the BlackBerry Performance
Engineering Resource Kit

To analyze the performance of the BlackBerry® Enterprise Server using the BlackBerry® Performance Engineering Resource Kit,
you require four computers in the test environment. Some BlackBerry Enterprise Server configurations that you can install require
additional computers (for example, a BlackBerry Enterprise Server with BlackBerry® MDS Services). If you install a BlackBerry
Enterprise Server with BlackBerry MDS Services, you must have enough computers to run the BlackBerry Enterprise Server in the
test environment.

Computer Requirements

computer that hosts the *  messaging server

messaging server performance monitor

computer that hosts the e BlackBerry Enterprise Server

BlackBerry Enterprise Server «  BlackBerry Load Test Configuration Tool

e Microsoft® Visual C++® 2005 C++ SP1 redistributable package (x86)
e Microsoft® .NET Framework 2.0
e performance monitor

computer that hosts the e Microsoft® SQL Server®

BlackBerry Configuration «  BlackBerry Configuration Database

Database

computer that hosts the load e BlackBerry Infrastructure and Smartphone Simulator

simulation tools e Microsoft® Visual C++® 2005 C++ SP1 redistributable package (x86)

e Microsoft .NET Framework 2.0
e for full functionality, a load generator

Related topics
System requirements: BlackBerry Performance Engineering Resource Kit, 7
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Pre-installation tasks

Configuring a messaging server

A test environment for the BlackBerry® Enterprise Server requires a messaging server unless you are testing the BlackBerry®
Enterprise Server for MDS Applications. The BlackBerry® Enterprise Server for Microsoft® Exchange, the BlackBerry® Enterprise
Server for IBM® Lotus® Domino®, and the BlackBerry® Enterprise Server for Novell® GroupWise® require a messaging server
to send email messages and other messages.

The messaging server in a test environment is typically not connected to the Internet, so you must configure the messaging server
to send messages within the test environment only.

You should make sure that you configure a load generator for use with the messaging server. The load generator creates the
messages that the BlackBerry Enterprise Server sends.

You can configure the messaging server in your test environment using the same method that you would use to configure a
messaging server of the same version that is associated with a BlackBerry Enterprise Server in your organization.

Backing up and restoring BlackBerry Enterprise Server information

Back up Microsoft Exchange mailboxes

To use the information in the BlackBerry® Enterprise Server, including the BlackBerry Configuration Database, with the
BlackBerry® Performance Engineering Resource Kit, you must back up both the BlackBerry Configuration Database and the user
mailboxes. You use the backups in your test environment to create a duplicate of your organization's environment.

Before you begin: Verify that the user accounts and the user mailboxes exist.

Stop the Microsoft® Exchange Information Store service.
Browse to C:\Program Files\Exchsrv.

Create a backup folder.

Copy the MDBData file into the backup folder that you created.
Start the Microsoft Exchange Information Store service again.

goa W

Restore the BlackBerry Enterprise Server and user mailboxes from backups

Before you begin:
e Verify that backups of the BlackBerry® Enterprise Server and the user mailboxes exist.
e Verify that both backups were made at the same time.
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In your test environment, stop the BlackBerry Enterprise Server.

On the computer that hosts the Microsoft® SQL Server® and the BlackBerry Configuration Database, restore the backup
of the BlackBerry Configuration Database.

On the computer that hosts the messaging server, restore the backup of the user mailboxes from the appropriate backup
folder. For more information about restoring backups, see the documentation for the messaging server.

Start the BlackBerry Enterprise Server.

Configure settings for BlackBerry Enterprise Server 4.1

You must configure settings for the BlackBerry® Enterprise Server 4.1 using the BlackBerry Configuration Panel.

1.

2.
3.

On the BlackBerry Server tab, in the Router Host field, type localhost.
In the Attachment Host field, type localhost.

Inthe SRP Authentication key field, type one of the SRP Authentication Keys thatare a part of the BlackBerry® Performance
Engineering Resource Kit. The keys are located in the <install_directory>\Documentation\SRP Keys.txt file on the computer
that hosts the BlackBerry Infrastructure and Smartphone Simulator.

On the Database Connectivity tab, in the SQL Server field, type the name of the Microsoft® SQL Server® that you use in
your organization's test environment.

In the SQL Server field and BlackBerry Configuration Database field, type the name of the BlackBerry Configuration
Database that you use in your organization's test environment.

On the BlackBerry Router tab, in the SRP Address field, type the name of the computer that hosts the BlackBerry
Infrastructure and Smartphone Simulator.

Click OK.

Configure settings for BlackBerry Enterprise Server 5.0 or later

You should choose an SRP authentication key for the BlackBerry® Enterprise Server. SRP authentication keys for the BlackBerry®
Infrastructure and Smartphone Simulator are stored on the computer that hosts the BlackBerry Infrastructure and Smartphone
Simulator, in the <install_directory>\Documentation\SRP Keys.txt file.

1.

© N O U AW

In the BlackBerry Administration Service, open Servers and components > BlackBerry Solution topology > Server view.
Click the name of the BlackBerry Enterprise Server that you want to configure.

In the right pane, click Server Configuration.

In the right pane, click Edit fields.

In the right pane, in the Authentication key field, type the SRP key.

Click OK.

On the computer that hosts the BlackBerry Enterprise Server, on the Start menu, click Run.

In the Open field, type regedit.
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9. Click OK.

BlackBerry Enterprise Server permissions

10. Inthe left pane of the Registry Editor, navigate to HKEY_LOCAL_MACHINE\Software\Research In Motion\BlackBerry

Enterprise Server\Database.

11.  If the Registry Editor does not contain the DatabaseName key and DatabaseServerMachineName key, create these keys.

12.  Inthe Registry Editor, in the DatabaseName field, type the name of the BlackBerry Configuration Database.

13.  Inthe Registry Editor, in the DatabaseServerMachineName field, specify the fully qualified domain name of the database

server.
14.  Click OK.

15.  Restart the BlackBerry Enterprise Server and the BlackBerry Administration Service.

BlackBerry Enterprise Server permissions

The BlackBerry® Enterprise Server requires specific permissions for the Microsoft® SQL Server® that hosts the BlackBerry
Configuration Database and for the messaging server in the test environment.

Item Permission

Microsoft SQL Server The BlackBerry Enterprise Server must have an account with the following credentials:
e login
e password

Microsoft® Exchange 2007 The BlackBerry Enterprise Server must have an account that is named BESAdmin with the

following permissions:

Owner for all public folders
ExtendedRight

Receive As

ms-Exch-Store-Admin

Log on Locally with Local Permissions
Log On As A Service

Each BlackBerry device user must have the following permissions:

Send As

Read for all public folders

Visible for all public folders

Schedule+free and busy for the system public folder

n
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Item
Microsoft Exchange 2003

IBM® Lotus® Domino®

Novell® GroupWise®

BlackBerry Enterprise Server permissions

Permission

The BlackBerry Enterprise Server must have an account that is named BESAdmin. The

account must be a member of the Domain User group and have the following permissions:

»  Exchange View Only Administrator with a minimum access level of Administrative
Croups

e SendAs

e Receive As

e Administer Information Store

e Owner permission on all public folders

In the Server document for the computer that hosts the IBM® Lotus® Domino® server,

the Run unrestricted methods and operation field must include the LocalDomainServers

group.
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Installing the BlackBerry Performance Engineering
Resource Kit

Prerequisites: Installing the BlackBerry Performance Engineering Resource
Kit
e Verifythatyou knowthe computer name, administrator name, password, and database name for the Microsoft® SQL Server®.

e Verify that you know the name of the BlackBerry® Enterprise Server and the name of the database.

e Verify that you installed the Microsoft® Visual C+® 2005 SP1 redistributable package (x86) on on each computer that
hosts the BlackBerry Load Test Configuration Tool and the computer that hosts the BlackBerry® Infrastructure and
Smartphone Simulator.

»  Verify that you installed the redistributable package for Microsoft® .NET Framework 2.0 on both the computer that hosts
the BlackBerry Enterprise Server and the computer that hosts the BlackBerry Infrastructure and Smartphone Simulator.

e Verify that you have an SRP key from the <install _directory>\Documentation\SRP Keys.txt file ready to use so that the
BlackBerry Enterprise Server can send messages to the BlackBerry Infrastructure and Smartphone Simulator and receive
messages from it.

Configuring the BlackBerry Infrastructure and Smartphone Simulator

Install the BlackBerry Infrastructure and Smartphone Simulator

You must install the BlackBerry® Infrastructure and Smartphone Simulator on a computer that does not host the BlackBerry®
Enterprise Server. When you are prompted for an SRP Authentication key, use an SRP Authentication key that is located in the
<install_directory>\Documentation\SRP Keys.txt file on the computer that hosts the BlackBerry Infrastructure and Smartphone
Simulator.

1. Loginto the computer that hosts the BlackBerry Infrastructure and Smartphone Simulator.

2. Inthe folder where the BlackBerry® Performance Engineering Resource Kit installer is located, run the BBISSim
\setup.exe file.

3. Follow the prompts.

Configure a location for the BlackBerry Configuration Database

When you start the BlackBerry Infrastructure and Smartphone Simulator for the first time, it performs the first two steps
automatically.

1. Inthe BlackBerry Infrastructure and Smartphone Simulator, open the Options dialog box.
2. Inthe left pane, click Server Configuration.

13
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In the Server field, type the name of the Microsoft® SQL Server®.
In the Database field, type the name of the BlackBerry Configuration Database.
In the Authentication drop-down list, select the type of authentication for the Microsoft SQL Server.

S

If the BlackBerry Configuration Database uses Microsoft SQL Server authentication, in the User field, type the user name
for the administrator account that accesses the BlackBerry Configuration Database.

7. IftheBlackBerry Configuration Database uses Microsoft SQL Server authentication, in the Password field, type the password
for the administrator account that accesses the BlackBerry Configuration Database.

To test the information that you entered on this dialog box, click Connect To Database.
9. Ifthe information is correct, click Save.

Example: Configure a test environment using Microsoft Exchange 2007

To perform this task, your test environment must include Microsoft® Exchange 2007, a load generator tool (either Microsoft
Exchange Load Generator or Microsoft Exchange Server 2003 Load Simulator), Microsoft® SQL Server®, and the BlackBerry®
Performance Engineering Resource Kit. The BlackBerry Load Test Configuration Tool is on the computer that hosts the BlackBerry®
Enterprise Server. The BlackBerry Infrastructure and Smartphone Simulator is on a separate computer.

1. Inthe test environment, using Microsoft® Active Directory®, deletethe user accounts that the load generator tool created
from Microsoft Exchange 2007.

2. Stop Microsoft Exchange 2007.

3. In Microsoft Exchange 2007, delete the contents of the First Storage group and Second Storage group.

4. Start Microsoft Exchange 2007 again.

5. Inthe Microsoft Exchange Management Console, mount the public folders and the database for the messaging server on
Microsoft Exchange 2007.

6. If you are prompted to have the load generator re-create the user accounts, click Yes.

7. Using Microsoft Active Directory, create a user account that is named BESAdmin.

8. InMicrosoft Exchange 2007, create an administrative user account that is named BESAdmin. Perform the following actions:
a. If the mailbox for the administrative user account exists, delete it.
b.  Create the administrative user account that is named BESAdmin.
c.  Create the mailbox for the administrative user account.

9. Back up the mailboxes of all user accounts.

10. Perform one of the following tasks:

Task Steps

Configure the test settings usingthe 5 Configure the test settings.
Microsoft Exchange Load Cenerator.
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b.  Update the Microsoft Exchange Load Generator configuration file so that
the number of populated email messages is zero. Perform the following
actions in the <UserGroups><UserGroup> section.

1. In<ActionProfileName="ProfileName">,change
<ProfileName>to Custom.

2. In<MailboxStoreProfileName="MailboxName">, change
<MailboxName> to Custom.

3. Inthe <UserGroups><UserGroup> section, change the values
for the tags that end in Count to 0, except for NewFolderCount.
c. Initialize the test configuration.
Con;igure setting; using th; Micr(l)soft a.  Configure the populated email messages to zero.
Exchange Server 2003 Load Simulator. 5 G e e e,

c. Initialize the user accounts.

Back up the mailboxes of all BlackBerry Enterprise Server user accounts.
On a separate computer from the other computers, install the BlackBerry Enterprise Server.
On the same computer, install the BlackBerry Load Test Configuration Tool.

In Microsoft Exchange 2007, create a file that contains the list of user accounts for the BlackBerry Load Test Configuration
Tool.

On the computer that hosts the BlackBerry Infrastructure and Smartphone Simulator, start the BlackBerry Infrastructure
and Smartphone Simulator.

Start the BlackBerry Enterprise Server.

Using the BlackBerry Load Test Configuration Tool, convert the user accounts into a format that the BlackBerry Infrastructure
and Smartphone Simulator can use.

Verify that the correct number of user accounts exists in the BlackBerry Enterprise Server.

Configuring the BlackBerry Load Test Configuration Tool

Install the BlackBerry Load Test Configuration Tool

You must install the BlackBerry® Enterprise Server before you install the BlackBerry® Load Test Configuration Tool because the
BlackBerry Load Test Configuration Tool is installed on the same computer and uses information stored by the BlackBerry
Enterprise Server. The BlackBerry Load Test Configuration Tool requires a list of fully qualified user accounts for BlackBerry®
device users.

1.

From its download location, copy the BlackBerry Load Test Configuration Tool setup application to the computer that hosts
the BlackBerry Enterprise Server that you want to test.
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2. Onthe computer, log in to the BlackBerry Enterprise Server as an administrator.
3. Inthe folder where you copied the setup application, run the BBLTConfig\setup.exe file.
4.  Follow the prompts.
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Post-installation tasks

Converting user accounts using the BlackBerry Load Test Configuration Tool

Prerequisites: Importing user accounts using the BlackBerry Load Test Configuration Tool

e Verify that the BlackBerry® Enterprise Server is running.

e Verify that the messaging server is running.

e Verify that you configured the administrator profile for the BlackBerry Enterprise Server correctly.

e Verify that you configured the permissions for the BlackBerry Enterprise Server correctly.

e Ifyou plan on testing BlackBerry Enterprise Server 4.1, verify that you can start the BlackBerry Manager successfully.

«  Ifyou planon testing BlackBerry Enterprise Server 5.0 or later, verify that you installed the BlackBerry® Administration API.

Generating a list of user accounts

You must provide the BlackBerry® Infrastructure and Smartphone Simulator with the text file that contains the user account list.
Each user account must be identified by a unique email address.

You must generate the user account list the first time you run the BlackBerry Load Test Configuration Tool and each time you
change the number of user accounts that are associated with the BlackBerry® Enterprise Server unless you are testing the wireless
activation process.

Each line of the user account list contains one email address. To create the user account list, use the method that is provided
with your messaging server or edit the list of statistics that the BlackBerry Enterprise Server exports.

Optionally, the list can also contain one PIN for each email address that is separated from the email address by a tab character.
You might use this if you have multiple BlackBerry Enterprise Server instances and you must run the BlackBerry Load Test
Configuration Tool again on one. The PIN is the PIN that the BlackBerry Infrastructure and Smartphone Simulator uses, not the
original PIN. If you include a PIN, each email address must have a PIN. Each PIN should be hexadecimal and should appear in
the list in sequential order, starting with F1000000.

Example: The format of user account list

# The BlackBerry Load Test Configuration Tool
# ignores lines that begin with # marks and ignores blank lines.
# [] indicates optional information.

<fully_qualified_email_address>[<tab><PIN>]

17
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Convert user accounts using the BlackBerry Load Test Configuration Tool

You must use the BlackBerry® Load Test Configuration Tool to convert PIN values that are in BlackBerry device user accounts so
thatthe BlackBerry® Infrastructure and Smartphone Simulator can use them. You must use the BlackBerry Load Test Configuration
Tool before you use the BlackBerry Infrastructure and Smartphone Simulator for the first time or after you change the sequence
of user accounts on the BlackBerry® Enterprise Server.

1.

o N o wu

On the computer that hosts the BlackBerry Enterprise Server, log in to the BlackBerry Enterprise Server as an administrator.
On the computer that hosts the BlackBerry Enterprise Server, start the BlackBerry Load Test Configuration Tool.

In the BlackBerry Load Test Configuration Tool, if multiple email profiles are available, click the profile that you want to use.
Click OK.

Ifyour organization is testing BlackBerry Enterprise Server 5.0 or later, in the appropriate fields, type the administrator login
information for the BlackBerry Administration Service.

Click Import the user list.

Navigate to the list of user accounts.
Click Import users.

Click Close.
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Using the BlackBerry Infrastructure and Smartphone 6
Simulator

Start the BlackBerry Infrastructure and Smartphone Simulator

1. On the computer that hosts the BlackBerry® Infrastructure and Smartphone Simulator, on the taskbar, click Start >
Programs > Research In Motion > Performance Engineering Resource Kit > BlackBerry Infrastructure and
Smartphone Simulator.

2. On the computer that hosts the BlackBerry Enterprise Server that you use in your test environment, start the BlackBerry
Enterprise Server.

Related topics
Pausing and resuming the BlackBerry Infrastructure and Smartphone Simulator, 19

Pausing and resuming the BlackBerry Infrastructure and Smartphone
Simulator

The BlackBerry® Infrastructure and Smartphone Simulator begins simulating the BlackBerry® Infrastructure and BlackBerry
devices as soon as it starts. The BlackBerry Infrastructure and Smartphone Simulator updates the counters and generates
messages based on the timer settings in a workload profile.

You can pause the simulation. When you pause the BlackBerry Infrastructure and Smartphone Simulator, the simulator stops
sending messages from simulated BlackBerry devices. The BlackBerry Infrastructure and Smartphone Simulator still receives
messages from the BlackBerry® Enterprise Server. You can pause the BlackBerry Infrastructure and Smartphone Simulator in
order to adjust a setting on the messaging server, the load generator, or the BlackBerry Enterprise Server. When you resume the
simulation, the BlackBerry Infrastructure and Smartphone Simulator resumes sending messages from simulated BlackBerry
devices.

If you have configured your BlackBerry Infrastructure and Smartphone Simulator to send many messages, the simulator stores
messages in a queue. When you pause the BlackBerry Infrastructure and Smartphone Simulator, it sends the messages in the
queue but creates no new ones.

When you save a workload profile, even while the BlackBerry Infrastructure and Smartphone Simulator is paused, the simulator
automatically starts sending messages again. The BlackBerry Infrastructure and Smartphone Simulator exits the paused state.

Related topics
Start the BlackBerry Infrastructure and Smartphone Simulator, 19

Pause the BlackBerry Infrastructure and Smartphone Simulator

In the BlackBerry Infrastructure and Smartphone Simulator, click Simulation > Pause.
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Resume the timers for the BlackBerry Infrastructure and Smartphone Simulator

In the BlackBerry Infrastructure and Smartphone Simulator, click Simulation > Start.

Viewing the name of the BlackBerry Enterprise Server instance that is
displayed in the BlackBerry Infrastructure and Smartphone Simulator

Inthe BlackBerry® Infrastructure and Smartphone Simulator you can see the names of the BlackBerry® Enterprise Serverinstances
that the simulator can connect to. The BlackBerry Infrastructure and Smartphone Simulator displays the details of only one
instance of the BlackBerry Enterprise Server at a time.

You can view the status of each BlackBerry Enterprise Server in the test environment. A BlackBerry Enterprise Server can have
a status of Authenticated, Connected, or Disconnected. A test using the BlackBerry Infrastructure and Smartphone Simulator
can be run only with authenticated instances of the BlackBerry Enterprise Server.

Associate new user accounts with the BlackBerry Enterprise Server of the
test environment

In test environments using a messaging server other than IBM® Lotus® Domino®, the BlackBerry® Load Test Configuration Tool
adds new user accounts to the BlackBerry® Enterprise Server automatically when you run the BlackBerry Load Test Configuration
Tool if their email addresses are in the list of user accounts.

Before you begin: Verify that the new user accounts exist on the messaging server.

1. Ifyour test environment uses a Lotus Domino messaging server, delete all user accounts from the BlackBerry Enterprise
Server associated with the Lotus Domino messaging server.

2. Onthe computer that hosts the BlackBerry Enterprise Server, add the email addresses of the new user accounts to the file
that contains the list of user accounts. Enter only one email address on each line of the file.

3. Runthe BlackBerry Load Test Configuration Tool.

Change user accounts that are associated with an instance of the BlackBerry
Enterprise Server of the test environment

1. Delete the user accounts from the BlackBerry® Enterprise Server using the appropriate BlackBerry Enterprise Server tool.
« Ifthe BlackBerry Enterprise Server is earlier than BlackBerry Enterprise Server 5.0, use the BlackBerry Manager.
- Ifthe BlackBerry Enterprise Server is BlackBerry Enterprise Server 5.0 or later, use the BlackBerry Administration Service.
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2. Onthe computer that hosts the BlackBerry Enterprise Server, delete the appropriate mail addresses from the file that
contains the list of user accounts.

3. Convert the user accounts using the BlackBerry Load Test Configuration Tool.
After you finish:

Verify that the number of user accounts that are available to the BlackBerry Infrastructure and Smartphone Simulator is the same
as the number of user accounts that are associated with the BlackBerry Enterprise Server.

Change a workload profile

A workload profile is a collection of settings that determines what protocols the BlackBerry® Infrastructure and Smartphone
Simulator sends, what messages the simulator sends, and how often. Any test that uses the BlackBerry Infrastructure and
Smartphone Simulator uses a workload profile.

Note: When you save aworkload profile, the current test starts running. If the BlackBerry Infrastructure and Smartphone Simulator
is paused, the simulator resumes.

1. Inthe BlackBerry Infrastructure and Smartphone Simulator, open the workload profile that you want to change, or create
a new workload profile.

2. Change the appropriate settings
3. Click Save until the main screen of the BlackBerry Infrastructure and Smartphone Simulator appears.

Related topics

Change an existing workload profile, 21

Add a new payload to a workload profile, 37

Delete a payload, 37

Add a calendar event payload to a workload profile, 43

Change an existing workload profile

You must update the workload profile for a workload to change the settings in the BlackBerry® Infrastructure and Smartphone
Simulator, such as the number of messages of each type that are sent.

1. Inthe BlackBerry Infrastructure and Smartphone Simulator, click Options.

2. Click the workload profile that you want to change.

3. Inthe left pane, click the part of the workload profile that you want to change.
4.  Change the appropriate values.

5. Click Save until the main screen of the simulator appears.

Related topics
Change a workload profile, 21
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Payloads and weights

A payload is the information that a message contains. The message can be anything that the BlackBerry® Infrastructure and
Smartphone Simulator sends, such as an email message, a calendar entry, a synchronization request, or an HTTP request. Each
message type has different properties. The BlackBerry Infrastructure and Smartphone Simulator determines the properties of
the payload randomly, such as its size, within the limits that you set. You can configure the limits of the payload for each type of
message in a workload profile. For example, you can define a small email message as one that has a body between 20 bytes and
200 bytes long.

If you define two or more types of payloads for a type of message, the weight is the percentage of messages that contain a given
payload. If you define only one payload, the payload has a weight of 100%. If you define two or more payloads, you can adjust

the percentage of time that each is sent. For example, you can define a small payload and a large payload for email messages,
and then specify the weights so that the BlackBerry Infrastructure and Smartphone Simulator sends the small payload 80% of
the time and the large payload 20% of the time. The total of the weights must be 100%.

The BlackBerry® Enterprise Server sends only messages that the messaging server sends. To specify the sizes of the messages
that the BlackBerry Enterprise Server sends, you must see the documentation for your load generator. The BlackBerry Enterprise
Server sends the changes that are made on the messaging server.

Changing the workload in a workload profile

You can use timers to configure the number of messages for each user account that the BlackBerry® Infrastructure and
Smartphone Simulator sends to the BlackBerry® Enterprise Server in an 8-hour period . You can change the amount of work that
the BlackBerry Enterprise Server does during a test by changing the number of messages that the BlackBerry Infrastructure and
Smartphone Simulator sends, or by changing the number of user accounts on the BlackBerry Enterprise Server.

The BlackBerry Enterprise Server sends service books and IT policies to BlackBerry devices. To configure the number of service
books or IT policies that the BlackBerry Infrastructure and Smartphone Simulator receives, change the appropriate settings for
the BlackBerry Enterprise Server.

Default workload profile settings

You can use the RIM® passive workload profile when you test the installation of the BlackBerry® Enterprise Server, messaging
server,load generator, and performance monitor. With the passive workload profile, the BlackBerry Infrastructure and Smartphone
Simulator receives messages from the BlackBerry Enterprise Server, but does not send messages from the BlackBerry devices.

The messages that are indicated in the workload profiles are messages that are sent to the BlackBerry Enterprise Server for each
userinan 8-hour period. In the default workload profiles, the BlackBerry Infrastructure and Smartphone Simulator does not send
HTTP requests.
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Configuration

calendar event payloads available

configuration of contact lookup
requests

configuration of email message
payloads, with all default payloads
having the following:

e 0BCCusers

e 0CCusers

e subject 20 bytes

»  default character encoding

e default sensitivity

Low workload
profile

simple event

location
between
10-20 bytes
notes
between
100-200
bytes
subject
between
20-40 bytes
reminder
time 15
minutes

0 other
recipients

1search
20-100
matches

simple email
message

1To user
body 100
bytes
normal
importance

Medium workload

profile

simple event

location
between
10-20 bytes
notes
between
100-200
bytes
subject
between
20-40 bytes
reminder
time 15
minutes

0 other
recipients
1search
20-100
matches

simple email
message

1To user
body 100
bytes
normal
importance

High workload
profile

Change a workload profile

RIM passive
workload profile

simple event

location
between
10-20 bytes
notes
between
100-200
bytes
subject
between
20-40 bytes
reminder
time 15
minutes

0 other
recipients

1search
20-100
matches

small email
message

1To user
body 100
bytes
normal
importance

large email
message

2 To users
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Configuration Low workload Medium workload High workload RIM passive
profile profile profile workload profile
e body
between
300-1000
bytes
e high
importance
number of calendar events 2 3 5
number of contact lookup requests 1 2 2

number of contact lookup requeststhat 0
search the messaging server

number of email messages 5 7 10
number of requests for free or busy 0 0 0
status

number of requests regardingaccessto 0 0 0
network documents

number of synchronization messages 3 4 6

for organizer data

percentage of BlackBerry device 4% 8% 12% 0%
messages that the BlackBerry

Infrastructure and Smartphone

Simulator adds attachments to,

requesting 1 block from the BlackBerry

Attachment Service 4.1 SP2

percentage of email messages that e 5%reply e 5%reply e 5%reply
cause reconciliation requests requests requests requests
e 3% forward e 3% forward e 3% forward
requests requests requests
e 1%delete e 1%delete e 1%delete
requests requests requests
weights of calendar event payloads e 20% create e 20% create e 20% create
appointment appointment appointment
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Configuration

weights of responses to meeting
requests

weights of email message payloads

weights of synchronization messages
for organizer data

Low workload
profile

25% update
appointment
5% delete
appointment
20% request
meeting
25% update
meeting

5% delete
meeting
10% accept
5% decline
70% ignore
5% tentative
10% forward

100% simple
email
messages

30% memos
30% task list
30% contacts
5% email
settings

Medium workload
profile

25% update
appointment
5% delete
appointment
20% request
meeting
25% update
meeting

5% delete
meeting
10% accept
5% decline
70% ignore
5% tentative
10% forward

100%:

O recurrences
small text
fields

100% simple
email
messages

30% memos
30% contacts
30% task list
5% email
settings

High workload
profile

Change a workload profile

RIM passive
workload profile
25% update
appointment
5% delete
appointment
20% request
meeting
25% update
meeting

5% delete
meeting
10% accept
5% decline
70% ignore
5% tentative
10% forward

value entered in
GUI but not used
by simulator

50% small
email
messages
50% large
email
messages
30% memos O
30%
contacts
30% task list
5% email
settings

25



Administration Guide Copy the organization's BlackBerry Enterprise Server settings

Configuration Low workload Medium workload High workload RIM passive
profile profile profile workload profile
e 5%email e 5%emall e 5%emall
filters filters filters

Copy the organization's BlackBerry Enterprise Server settings

You can copy the mailboxes and the settings from the BlackBerry® Enterprise Server for the organization to the test environment
instead of creating a new configuration for the BlackBerry Configuration Database. You must back up the mailboxes and the
BlackBerry Configuration Database at the same time.

1. Ifyourorganization uses Microsoft® Exchange, back up the user mailboxes for the user accounts associated with BlackBerry
devices.

Back up the BlackBerry Configuration Database that is associated with the user accounts.

Ifyour organization uses Microsoft Exchange, on the computer that hosts the test environment's Microsoft Exchange, restore
the mailboxes using the backup copy that you created in step 1.

4. Onthe computer that hosts the test environment's Microsoft® SQL Server®, restore the BlackBerry Configuration Database
from the backup copy that you created in step 2.

Change the workload in a workload profile

Type a number for the timer that you want to change.

1. Inthe BlackBerry Infrastructure and Smartphone Simulator, click Options.
2. Click the workload profile that you want to change.

3. Click Edit.

4. Click Timers.

5.

6.

Click Save until the main screen of the BlackBerry Infrastructure and Smartphone Simulator appears.

Choose the BlackBerry Enterprise Server instances to test

You can use one instance of the BlackBerry® Infrastructure and Smartphone Simulator to test multiple instances of the BlackBerry
Enterprise Server. The BlackBerry Enterprise Server instances that you test must use the same BlackBerry Configuration Database.

Before you begin:

Verify that all BlackBerry® Enterprise Server instances use the same BlackBerry Configuration Database.

1. Inthe BlackBerry Infrastructure and Smartphone Simulator, click Options.
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In the left pane, click Profile Configuration.

In the Profile Assignment section, perform the following actions for each BlackBerry Enterprise Server instance in the test
environment:

« Toinclude the instance in the next test that the BlackBerry Infrastructure and Smartphone Simulator runs, select the
workload profile from the drop-down list beside the instance name. Make sure the check box in the Active column is
selected.

» Toexclude the instance from the next test that the BlackBerry Infrastructure and Smartphone Simulator runs, make sure
the check box in the Active column is clear.

Click OK.
Click Save until the BlackBerry Infrastructure and Smartphone Simulator displays the main screen.
Restart the BlackBerry Infrastructure and Smartphone Simulator.

Testing the wireless activation process

The wireless activation process activates BlackBerry® devices that are associated with a BlackBerry® Enterprise Server over the
wireless network. Neither you nor the BlackBerry device users are required to connect the BlackBerry devices to a computer in
your organization's network to complete the activation process.

The BlackBerry® Infrastructure and Smartphone Simulator uses the wireless activation process to activate any user account that
you add to an active BlackBerry Enterprise Server after you run the BlackBerry Load Test Configuration Tool.

To test the activation process, add one or more user accounts to the active BlackBerry Enterprise Server instance that has the
highest ServerConfiglID value. The BlackBerry Enterprise Server must be configured to use the wireless activation process.

The BlackBerry Infrastructure and Smartphone Simulator requires a contiguous string of PIN values. The simulator attempts to
fill any gaps created by the removal of user accounts and then adds new PIN values to the active BlackBerry Enterprise Server
with the highest ServerConfigID. If the BlackBerry Infrastructure and Smartphone Simulator cannot fill in the gaps, it displays a
request that you use the BlackBerry Load Test Configuration Tool to add the users.

Test the wireless activation process
Before you begin: Verify that the new user account exists on the messaging server.

1. With the appropriate tool, add the user accounts to the active BlackBerry® Enterprise Server that has the highest
ServerConfiglD in the test environment.

- Ifthe BlackBerry Enterprise Server is earlier than BlackBerry Enterprise Server 5.0, use the BlackBerry Manager.
« Ifthe BlackBerry Enterprise Server is BlackBerry Enterprise Server 5.0 or later, use the BlackBerry Administration Service.

Start (or restart) the BlackBerry Infrastructure and Smartphone Simulator.
In the dialog box, enter the SMTP address of the messaging server.
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4.  Enter the number of user accounts you want to activate every second. The maximum value is 10.
5. Click OK.
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Changing debug settings and log settings

Overview: log console

The BlackBerry® Infrastructure and Smartphone Simulator writes debug information and log information to log files, the test
report, and to the log console. You can configure the log console to display less or more information than the files capture. For
example, you can configure the BlackBerry Infrastructure and Smartphone Simulator to capture all information (debug level 5
and log level 5), but you can configure the log console to display only level Tinformation.

The log console does not wrap text from one line to the next. To examine a long line in the console, you can highlight the text or
pause the simulation.

If you highlight text in the log console, the BlackBerry Infrastructure and Smartphone Simulator stops updating the log console.
The BlackBerry Infrastructure and Smartphone Simulator resumes updating the log console when you cancel the selection.

If new log messages are available in the log console but the log console is not displayed, an asterisk (*) appears beside the log
tab name in the BlackBerry Infrastructure and Smartphone Simulator. The asterisk disappears after you display the log console.
To clear the log console, click Clear.

The BlackBerry Infrastructure and Smartphone Simulator records log information using the same format as the BlackBerry®
Enterprise Server log files.

Set the level of detail that the log console displays

1. Inthe BlackBerry® Infrastructure and Smartphone Simulator, click Options.

2. Inthe GUI Console Log Level drop-down list, click the setting that you want the BlackBerry Infrastructure and Smartphone
Simulator to display in the log console. The descriptions of each level are provided in the drop-down list.

Set the level of detall of the debug log file

1. Inthe BlackBerry® Infrastructure and Smartphone Simulator, click Options.
2. Inthe Debug Log File Level drop-down list, click the level of information that you want recorded in the debug log file.
3. Click Save until the main screen of the BlackBerry Infrastructure and Smartphone Simulator appears.
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Changing the number of messages that the BlackBerry  IEEEN
Infrastructure and Smartphone Simulator sends to the
BlackBerry Enterprise Server

Timers and counters

You can use the BlackBerry® Infrastructure and Smartphone Simulator to configure both timers and counters. Timers control the
workload that the BlackBerry Infrastructure and Smartphone Simulator is testing, and counters display the number of messages
that the BlackBerry Infrastructure and Smartphone Simulator sends to BlackBerry® Enterprise Server or receives from the
BlackBerry Enterprise Server.

Timers regulate the number of messages that the BlackBerry Infrastructure and Smartphone Simulator sends for each user
accountinan 8-hour period (a typical business day). You can configure the number of messages that the BlackBerry Infrastructure
and Smartphone Simulator sends by configuring the timers in a workload profile.

Counters calculate the data packets and messages that the BlackBerry Infrastructure and Smartphone Simulator sends and
receives during a simulation. You can view the counters on the Statistics tab of the BlackBerry Infrastructure and Smartphone
Simulator. To reset the counters to O, click the Reset Counters button.

Each BlackBerry Enterprise Server with a separate UID has its own set of counters. You can reset the counters to 0 by clicking
the Reset Counters button.

You can also use the BlackBerry Infrastructure and Smartphone Simulator to view counters for messages that only the BlackBerry
Enterprise Server sends, such as IT policies and service books. The BlackBerry Infrastructure and Smartphone Simulator receives
that information and sends acknowledgments to the BlackBerry Enterprise Server.

Statistics and reports

You can see the statistics and reports for the BlackBerry® Enterprise Server that is displayed in the BlackBerry Infrastructure and
Smartphone Simulator or for all instances of the BlackBerry Enterprise Server that are part of the test. The statistics and reports
record the number of times or the percentage of time that specific events have happened in the test.

You can view statistics to see the number of times that events happen to the BlackBerry Enterprise Server instance that is currently
displayed.

You can view reports to see the same statistics for all of the active BlackBerry Enterprise Server instances.
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Statistics that the BlackBerry Infrastructure and Smartphone Simulator
generates

You can see statistics of the current test on the Statistics tab in the BlackBerry® Infrastructure and Smartphone Simulator. The
Statistics tab displays the items that you can view statistics for, such as Email, Calendar, and Web Browsing.

The Statistics tab displays the number of events that occur from the time that the BlackBerry® Enterprise Server connects to the
BlackBerry Infrastructure and Smartphone Simulator or from the time that the counters are restarted. You can reset the counters
to zero for a new test.

You can hide or display statistics.

Statistics are relative to the BlackBerry Infrastructure and Smartphone Simulator. A statistic that uses the term "sent" counts a
particular message or signal that the BlackBerry Infrastructure and Smartphone Simulator sends. A statistic that uses the term
"received" counts a particular message or signal that the BlackBerry Infrastructure and Smartphone Simulator receives. This
might not be the same number of messages or signals that the BlackBerry Enterprise Server sends.

Related topics

List of counters in the BlackBerry Infrastructure and Smartphone Simulator, 31
List of timers in the BlackBerry Infrastructure and Smartphone Simulator, 34
View the configuration values for timers, 31

List of timers in the BlackBerry Infrastructure and Smartphone Simulator, 34
List of counters in the BlackBerry Infrastructure and Smartphone Simulator, 31

View the configuration values for timers

Each workload profile has its own settings for timers.

1. Inthe BlackBerry® Infrastructure and Smartphone Simulator, click Options.
2. Click a workload profile.

3. Click Edit.

4. Click Timers.

Related topics

Statistics that the BlackBerry Infrastructure and Smartphone Simulator generates, 31
List of timers in the BlackBerry Infrastructure and Smartphone Simulator, 34

List of counters in the BlackBerry Infrastructure and Smartphone Simulator, 31

List of counters in the BlackBerry Infrastructure and Smartphone Simulator

This list does not include counters that are self-explanatory, such as Compressed Bytes Sent.
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Counter

Mail
Email Moved

OTAFM MTHs Received

OTAFM MFHs Sent

Total Attachments

Completed

Calendar
Meeting Requests Received

Meeting Requests Sent

Meeting Updates Sent

Web browsing

32

IPPP Disconnect Received

List of counters in the BlackBerry Infrastructure and Smartphone Simulator

Description

This counter displays the number of email messages that the BlackBerry® Infrastructure and
Smartphone Simulator moves between folders on BlackBerry devices.

This counter displays the number of reconciliation messages that the BlackBerry® Enterprise
Server sends to the BlackBerry Infrastructure and Smartphone Simulator. Reconciliation
messages include status updates (whether an email message is read, filed, or deleted) and folder
synchronization (whether the messaging server created, deleted, moved, or renamed a
synchronized folder).

This counter displays the number of reconciliation messages that the BlackBerry Infrastructure
and Smartphone Simulator sends to the BlackBerry Enterprise Server.

This counter displays the number of attachments that the BlackBerry Infrastructure and
Smartphone Simulator acknowledges as fully transmitted. This number should match or be lower
than the number of attachment responses that the BlackBerry Infrastructure and Smartphone
Simulator receives.

This counter displays the number of meeting request messages that the BlackBerry
Infrastructure and Smartphone Simulator receives. The messaging server must send the meeting
requests. The BlackBerry Infrastructure and Smartphone Simulator counts the meeting requests
inthe Meeting Requests Received counter and in the Email Messages Received counter, because
a meeting request is sent as an email message.

This counter displays the number of meeting request messages that the BlackBerry
Infrastructure and Smartphone Simulator sends. The BlackBerry Infrastructure and Smartphone
Simulator counts the meeting requests in the Meeting Requests Received counter and in the
Email Messages Received counter, because a meeting request is sent as an email message
This counter displays the number of appointments deleted messages that the BlackBerry
Infrastructure and Smartphone Simulator receives. The simulator and the messaging server both
can create these messages.

This counter displays the number of sessions that close while the BlackBerry Infrastructure and
Smartphone Simulator is exchanging HTTP information or DFTP information.
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Counter

Remote Desktop Received

Contact lookup
Search Matches

Sync
Device Sessions Opened

Server Sessions Opened

SRP

Total MTHs Received

Total MFHs Sent

Total MTH Status Sent

Total MFHs Status
Received

GME Errors Received

Pings Received

List of counters in the BlackBerry Infrastructure and Smartphone Simulator

Description

This counter displays the number of DFTP responses that the BlackBerry Infrastructure and
Smartphone Simulator receives. The BlackBerry Infrastructure and Smartphone Simulator
receives DFTP responses after it downloads a file or requests folder contents or the properties
of a folder or file. The number of DFTP responses does not equal the number of DFTP packets
received — a single file can take one or more packets to deliver but causes only one response.

This counter displays the number of results for contact lookup requests that match the criteria
that the BlackBerry Infrastructure and Smartphone Simulator sends.

This counter displays the number of times that the simulated BlackBerry devices opens a
synchronization session. A BlackBerry device might have several synchronization sessions in an
eight-hour period or it might have none. The BlackBerry device might not open a session for
synchronization because the BlackBerry Synchronization Service opens one first.

This counter displays the number of times the BlackBerry Synchronization Service has opened
a session for synchronization.

This counter displays the number of data packets that the BlackBerry Infrastructure and
Smartphone Simulator receives for BlackBerry devices. The BlackBerry Infrastructure and
Smartphone Simulator receives more data packets than this number .

This counter displays the data packets that the BlackBerry Infrastructure and Smartphone
Simulator sends to the BlackBerry Enterprise Server as if from BlackBerry devices.

This counter displays the number of times that the BlackBerry Infrastructure and Smartphone
Simulator receives status requests for a BlackBerry device from the BlackBerry Enterprise Server.
This counter displays the acknowledgments that the BlackBerry Infrastructure and Smartphone
Simulator receives from the BlackBerry Enterprise Server about the status of a specific BlackBerry
device.

This counter displays the number of data packets that contain errors at the higher protocol level.
The order of protocols is the SRP protocol, and within that the GME protocol, and within that,
protocols for specific tasks such as email messages, calendar events, or service books. A high
number of GME errors typically indicates a configuration error in the test environment.

This counter displays the number of pings that the BlackBerry Infrastructure and Smartphone
Simulator receives. A ping is a signal that is designed to verify that the connection with the
BlackBerry Enterprise Server is still open.
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Counter Description
Ping Responses Sent This counter displays the number of responses to pings that the BlackBerry Infrastructure and
Smartphone Simulator sends.

Successful Authentications — This counter displays the number of times that the BlackBerry Infrastructure and Smartphone
Simulator successfully authenticates a BlackBerry Enterprise Server.

Failed Authentications This counter displays the number of times that the BlackBerry Infrastructure and Smartphone
Simulator fails to successfully authenticate a BlackBerry Enterprise Server.

Disconnects This counter displays the number of times that the BlackBerry Infrastructure and Smartphone
Simulator sends the message that a BlackBerry device disconnects or is out of range.

IT policy

IT Policies Received This counter displays the number of IT policies that the BlackBerry Infrastructure and

Smartphone Simulator receives from the BlackBerry Enterprise Server. An IT policy is specific
tothe configuration of the BlackBerry Enterprise Server and applies to one or more user accounts.
Service books
Service Books Received This counter displays the number of service books that the BlackBerry Infrastructure and
Smartphone Simulator receives. BlackBerry devices never send service books.
Related topics
List of timers in the BlackBerry Infrastructure and Smartphone Simulator, 34
Statistics that the BlackBerry Infrastructure and Smartphone Simulator generates, 31

Statistics that the BlackBerry Infrastructure and Smartphone Simulator generates, 31
View the configuration values for timers, 31

List of timers in the BlackBerry Infrastructure and Smartphone Simulator

A timer determines the number of messages of a certain type that the BlackBerry® Infrastructure and Smartphone Simulator
sends to the BlackBerry® Enterprise Server for each user account in an 8-hour period. Each workload profile in the BlackBerry
Infrastructure and Smartphone Simulator can have different timer values..

Timer Description

Email This timer controls the number of email messages that the BlackBerry Infrastructure and Smartphone
Simulator sends to a BlackBerry® Enterprise Server. You can configure the size of the subject and the
amount of body text and the number of recipients as email properties in the workload profile.
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Timer

Calendar
Appointment

Contact Lookup

Browsing

Sync

Related topics

List of timers in the BlackBerry Infrastructure and Smartphone Simulator

Description

This timer controls the number of calendar appointments that the BlackBerry Infrastructure and
Smartphone Simulator sends to a BlackBerry Enterprise Server. You can configure the text fields, times,
and recurrence as calendar properties in the workload profile. The BlackBerry Infrastructure and
Smartphone Simulator can acceptany calendar meeting requests that the BlackBerry Enterprise Server
sends.

This timer controls the number of contact lookup requests that the BlackBerry Infrastructure and
Smartphone Simulator sends to a BlackBerry Enterprise Server. You can configure the contents of the
contact lookup requests as contact lookup properties in the workload profile.

This controls the number of web browsing requests that the BlackBerry Infrastructure and Smartphone
Simulator sends to a BlackBerry Enterprise Server. The BlackBerry Infrastructure and Smartphone
Simulator uses real web sites, and the contents of the HTTP message replies depend on the web
addresses sent. If a web address is not valid, the BlackBerry MDS Connection Service sends the
BlackBerry Infrastructure and Smartphone Simulator a notification that the address is invalid. You can
configure the web addresses as web browsing properties in the workload profile.

This controls the number of synchronization messages that the BlackBerry Infrastructure and
Smartphone Simulator sends to a BlackBerry Enterprise Server. You can configure the weights of the
synchronization messages as properties in the workload profile.

List of counters in the BlackBerry Infrastructure and Smartphone Simulator, 31
Statistics that the BlackBerry Infrastructure and Smartphone Simulator generates, 31
Statistics that the BlackBerry Infrastructure and Smartphone Simulator generates, 31
View the configuration values for timers, 31

Maximum rates

The BlackBerry® Infrastructure and Smartphone Simulator has maximum values for sending messages from simulated BlackBerry
devices. These limits are for sending only; the tool can receive as many messages as the messaging server can send and the

network supports.

Timer

Email messages
Calendar messages

Maximum value

20 messages/day/user
12 messages/day/user

Address lookup requests 25 messages/day/user
Browser requests (MDS protocol) 20 messages/day/user
PIM Synchronization requests 20 messages/day/user
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Reset counters for a BlackBerry Enterprise Server

1. Inthe BlackBerry® Infrastructure and Smartphone Simulator, in the left pane, click the name of a BlackBerry® Enterprise
Server.

On the Statistics tab, click Reset Counters.
Click Yes.

Turn on or off a counter

You can turn on or off counters for tests of a particular BlackBerry® Enterprise Server.

1. Inthe BlackBerry® Infrastructure and Smartphone Simulator, in the left pane, click the name of a BlackBerry Enterprise
Server.

On the Statistics tab, in the Find Counter field, type all or part of the name of the counter you want to turn on or off.
To turn on or off a counter, select the check box beside the name of the counter.
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Changing an email message simulation 9

Add a new payload to a workload profile

1. Inthe BlackBerry® Infrastructure and Smartphone Simulator, click Options.

2. Select the workload profile you want to change. Click Edit.

3. Inthelist on the left side of the dialog box, click the type of message that you want to change, such as Email.
4. Click Add.

5. To change the name of the payload, click New Payload.

6. Type a name for the payload.

7. Click the payload. Click Edit.

8. Configure the properties of the new payload.

9. Click Save.

10. To close the BlackBerry Infrastructure and Smartphone Simulator Settings dialog box, click Save.

Related topics
Change a workload profile, 21

Delete a payload

1. Inthe BlackBerry® Infrastructure and Smartphone Simulator, click Options.

2. Select the workload profile you want to change and click Edit.

3. Select the payload that you want to delete.

4. Click Remove.

5. Click Save until the main screen of the BlackBerry Infrastructure and Smartphone Simulator appears.

Related topics
Change a workload profile, 21

Change the properties of the email simulation

By default, when you create a new workload profile, the BlackBerry® Infrastructure and Smartphone Simulator sends email
messages as if from the simulated BlackBerry devices. You do not need to turn on email simulation.

1. Inthe BlackBerry Infrastructure and Smartphone Simulator, click Options.

2. Select the workload profile that you want to change. Click Edit.

3. Inthelist on the left side of the dialog box, click the type of message that you want to change, such as Email.
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Add, change, or remove the email message payloads that you want to use.

Change the properties about message views by specifying the percentage of all email messages that go to the simulated
BlackBerry devices are read, deleted, replied to, and forwarded.

Specify the percentage of email messages that have attachments for which the BlackBerry Infrastructure and Smartphone
Simulator requests the contents of the attachment.

Click Save until the main screen of the BlackBerry Infrastructure and Smartphone Simulator appears.

Change the properties of a payload
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In the BlackBerry® Infrastructure and Smartphone Simulator, click Options.

Select the workload profile that you want to change Click Edit.

In the list on the left side of the dialog box, click the type of message that you want to change, such as Email.
Click Edit.

To change the name of the payload, click the existing name and type the new name.

Click Edit.

Change the properties for the payload.

Click Save until the main screen of the BlackBerry Infrastructure and Smartphone Simulator appears.

Properties of email messages

Several properties have minimum and maximum size fields. If the entries in the minimum and maximum size fields are different,
the BlackBerry Infrastructure and Smartphone Simulator generates values in those ranges and uses randomly generated text to

meet them.

Property Description

To Users This property specifies the number of users in the To: field of the email messages that the
BlackBerry Infrastructure and Smartphone Simulator generates for this payload. The default
is1.

CC Users This property specifies the number of users in the CC: field of the email messages that the
BlackBerry Infrastructure and Smartphone Simulator generates for this payload . The default
is 0.

BCC Users This property specifies the number of users in the BCC: field of the email messages that the
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Property
Signature

Sensitivity

Importance

Character Encoding

Subject

Body

Change the properties of the email simulation

Description

This specifies the type of signature in the email messages that the BlackBerry Infrastructure
and Smartphone Simulator generates for this payload. The possible signatures are None or
Corporate Standard. The default is None. The messaging server contains the definitions of
signatures.

This property specifies the level of sensitivity of the email messages that the BlackBerry
Infrastructure and Smartphone Simulator generates for this payload. The possible levels of
sensitivity are None, Personal, Private, or Confidential. The default is None.

This property specifies the level of importance of the email messages that the BlackBerry
Infrastructure and Smartphone Simulator generates for this payload. The possible levels of
importance are Normal, High, or Low. The default is Normal.

This property specifies the text encoding of the email messages that the BlackBerry
Infrastructure and Smartphone Simulator uses for this payload. The possible text encodings
are Latin-1or Unicode. The default is Latin-1.

This property specifies the minimum and maximum size in bytes of the subject for the email
messages that the BlackBerry Infrastructure and Smartphone Simulator generates for this
payload. The default is 20 bytes for each size. The maximum value that you can enter in each
field is 200 bytes.

This property specifies the minimum and maximum size in bytes of the body text for the email
messages that the BlackBerry Infrastructure and Smartphone Simulator generates for this
payload. The default is 100 bytes for each size. The maximum value that you can enter in
each field is 10,000 bytes.

Change message viewing properties

Message viewing properties control whether the simulated message is marked read, deleted, replied to, forwarded, or generates
an attachment request. The ratio set is the input of the system: if Messages read is set to 20%, the BlackBerry® Infrastructure
and Smartphone Simulator marks two out of ten incoming messages as read.

1. Inthe BlackBerry Infrastructure and Smartphone Simulator, open the workload profile.
2. Inthe panel on the right side, set the properties.
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Change the properties of the email simulation

Properties of message views

For a percentage of the email messages that the BlackBerry® Infrastructure and Smartphone Simulator receives, the simulator
changes the status of the messages, depending on the values of the properties of message views. These message view statuses
apply to a percentage of all email messages that the BlackBerry Infrastructure and Smartphone Simulator receives, not only the
email messages carrying a specific payload. The percentage is called a ratioin the user interface. A message can be read, deleted,
replied to, forwarded, or be unread. These properties of message views are set for each workload profile.

Achange inthe status of an email message is a reconciliation. When an email message is reconciled, the BlackBerry Infrastructure
and Smartphone Simulator sends information about the reconciliation of that email message to the BlackBerry® Enterprise Server.
These messages affect the workload of the BlackBerry Enterprise Server.

Property
Read ratio

Delete ratio

Reply ratio

Forward ratio

Attachment Request ratio

Description

This property specifies the percentage of email messages that the BlackBerry Infrastructure
and Smartphone Simulator receives and marks as read. The maximum value is 50%.

This property specifies the percentage of email messages that the BlackBerry Infrastructure
and Smartphone Simulator receives and marks as deleted. The maximum value is 70%.

This property specifies the percentage of email messages that the BlackBerry Infrastructure
and Smartphone Simulator receives and generates a reply email message for. The maximum
value is 15%.

This property specifies the percentage of email messages that the BlackBerry Infrastructure
and Smartphone Simulator receives and forwards. The maximum value is 15%.

This property specifies the percentage of email messages with attachments that the BlackBerry
Infrastructure and Smartphone Simulator receives and generates an attachment request for.
The maximum value is 15%.

The BlackBerry Infrastructure and Smartphone Simulator generates attachment information
requests based on the number of email messages that have attachments, not on the total
number of email messages. If your load generator is configured so that the messaging server
never sends email messages with attachments, the BlackBerry Infrastructure and Smartphone
Simulator does not send attachment requests.

Change the weights of email message payloads

If you define only one email message payload, the weight of that payload is 100%. If you define two or more payloads, then the
total of the weights of all payloads in that workload profile must equal 100%.

1. Inthe BlackBerry® Infrastructure and Smartphone Simulator, click Options.
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Select the workload profile you want to change. Click Edit.

In the list on the left side of the dialog box, click type of message that you want to change, such as Email.
Click the weight of the payload that you want to change.

In the Weight field, type a new weight.
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Click Save until the main screen of the BlackBerry Infrastructure and Smartphone Simulator appears.

1



Administration Guide Changing the properties of calendar simulations

Changing the properties of calendar simulations

Meetings and appointments

On a BlackBerry® Enterprise Server, calendar events can be either appointments or meetings. For the BlackBerry Infrastructure
and Smartphone Simulator, a meeting is an appointment with email recipients. The BlackBerry Infrastructure and Smartphone
Simulator can respond to meeting invitations with acceptances, tentative acceptances, cancellations, or forwarding, or it can
ignore the request. The BlackBerry Infrastructure and Smartphone Simulator also generates meeting invitations. The responses
come from the BlackBerry Infrastructure and Smartphone Simulator and the load generator.

The BlackBerry Enterprise Server sends and synchronizes calendar appointments and calendar meetings in different ways. The
BlackBerry Enterprise Server sends and synchronizes calendar appointments using the calendar protocol, CICAL. It sends and
synchronizes meeting invitations as email messages using the email protocol, CMIME. (These names can appear in BlackBerry
Enterprise Server log files.) BlackBerry® device users send responses to calendar meeting requests as email messages. A meeting
response increases the number of email messages that the BlackBerry Infrastructure and Smartphone Simulator sends, while an
appointment response increases the number of calendar responses that the BlackBerry Infrastructure and Smartphone Simulator
sends. The increase in the statistics for both email messages and calendar responses is visible in the statistics.

Whether the BlackBerry Enterprise Server sends appointment requests or meeting requests depends on the configuration of the
load generator for the messaging server. Whether the BlackBerry Infrastructure and Smartphone Simulator sends appointment
requests or meeting requests depends on the calendar event payload it uses and the weights of the payloads. Calendar event
payloads are set in the workload profile.

Properties of a calendar event payload

Each calendar event payload has the following properties. You can configure the properties separately for each calendar event
payload in a workload profile.

Property Description

Busy Status This property specifies the status of the Busy field for a calendar event. A calendar event payload can have
a status of Free, Tentative, Busy, or Out of Office.

The default status is Free.

Location This property specifies the minimum size and maximum size, in bytes, of the Location field for a calendar
event payload. The maximum value for each field is 200 bytes.

The default value for the minimum size is 10 bytes. The default value for the maximum size is 20 bytes.
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Property
Notes

Reminder

Number of

Recipients

Recurrences

Subject

Add a calendar event payload to a workload profile

Description

This property specifies the minimum size and maximum size, in bytes, of the Notes field in a calendar event
payload. The maximum value for each field is 10,000 bytes.

The default setting for the minimum size is 100 bytes. The default value for the maximum size is 200 bytes.
This property specifies the time, in minutes, for the event reminder. The reminder time can be configured
to None, or as low as O minutes. The maximum value for this property is 560,640 minutes (which equals
approximately a year and a month).

The default time is 15 minutes.

This property specifies the number of email addresses for this calendar meeting. The property applies only
to calendar meetings. The messaging server, not the BlackBerry® Infrastructure and Smartphone
Simulator, determines the maximum number of recipients.

The default number of recipients is 0, making the default calendar event an appointment.
This property specifies whether and how often this calendar event recurs.

The maximum number of times that an event can recur is 100 times. The available time increments are
Daily, Weekly, Monthly, and Yearly.

The default number of times that an event can recur is 0. The default time increment is Daily.
This property specifies the minimum size and maximum size, in bytes, of the subject for this calendar event
payload. The maximum value in each field is 200 bytes.

The default value for the minimum size is 20 bytes. The default value for the maximum size is 30 bytes.

Add a calendar event payload to a workload profile

Click Add.
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In the BlackBerry® Infrastructure and Smartphone Simulator, click Options.
Select the workload profile that you want to change. Click Edit.
On the left side of the New Workload dialog box, click Calendar.

To change the name of the payload or create a payload, click New Payload.

Type a name for the payload.

Click the payload name. Click Edit.

Change the properties of the payload.

Click Save until the BlackBerry Infrastructure and Smartphone Simulator displays the main screen.
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Related topics
Change a workload profile, 21

Change the properties of a calendar event payload

A calendar event payload has a number of recipients, a reminder, a recurrence, and a busy status. You can also specify the size
of the text sections of the calendar event payload.

1. Inthe BlackBerry® Infrastructure and Smartphone Simulator, click Options.

2. Select the workload profile that you want to change. Click Edit.

3. Onthe left side of the New Workload dialog box, click Calendar.

4. Entering the values in the appropriate fields, set the properties for this calendar event.

5. Click Save until the BlackBerry Infrastructure and Smartphone Simulator displays the main screen.

Change the weights of calendar event payloads

If you define only one calendar event payload, the weight of that payload is 100%. If you define two or more calendar event
payloads, the total weight of the payloads must equal 100%.

1. Inthe BlackBerry® Infrastructure and Smartphone Simulator, click Options.

2. Select the workload profile that you want to change. Click Edit.

3. Onthe left side of the New Workload dialog box, click Calendar.

4. Inthe field of the payload type that you want to change, type a weight.

5. Click Save until the BlackBerry Infrastructure and Smartphone Simulator displays the main screen.

Change the weights of responses to meeting requests

Enter the responses to meeting requests on the dialog box that lists the calendar event payloads.
1. Inthe BlackBerry® Infrastructure and Smartphone Simulator, click Options.

2. Select the workload profile that you want to change. Click Edit.

3. Onthe left side of the New Workload dialog box, click Calendar.
4

In the Meeting Request Receipt Behavior section, select the weight of each response.
The weights must total 100.

5. Click Save until the main screen of the BlackBerry Infrastructure and Smartphone Simulator appears.

Change the properties of a calendar event payload

1. Inthe BlackBerry® Infrastructure and Smartphone Simulator, click Options.
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Click the workload profile you want to change. Click Edit.

On the left side of the Workload profiles dialog box, click Calendar.

Click the calendar event payload that you want to change. Click Edit.

Change the time, number of recipients, and status properties for the calendar event.

Change the minimum sizes and maximum sizes for the subject, location, and notes.

Click Save until the BlackBerry Infrastructure and Smartphone Simulator displays the main screen.

Configure how often Free/Busy flags change

Each workload profile can specify a different number of requests for Free/Busy information for each user account in an 8-hour
day. The BlackBerry® Infrastructure and Smartphone Simulator limits the number of Free/Busy requests that it sends at once to
the number of user accounts or 10, whichever is fewer.

1.
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In the BlackBerry Infrastructure and Smartphone Simulator, click Options.

Click the name of the workload profile that you want to change the flags for.

Click Edit.

In the left pane of the dialog box, click Timers.

In the Free/Busy Lookup field, type the number of times that the flag is changed for each user account in an 8-hour period.
Click Save until the BlackBerry Infrastructure and Smartphone Simulator displays the main screen.

45



Administration Guide Changing properties for a contact lookup simulation

Changing properties for a contact lookup simulation

Properties of a contact lookup simulation

When you specify a criteria for contact lookup requests in a workload profile in the BlackBerry® Infrastructure and Smartphone
Simulator, you can change the following properties:

«  whether the criteria for contact lookup requests are generated from email messages that the BlackBerry® Enterprise Server
sends or from the information that you provide

e thetexttofind in the user directory
e whether the criterion is a first name, last name, or a company name

e thenumberof contact lookup requests that the BlackBerry Infrastructure and Smartphone Simulator sends to the BlackBerry
Enterprise Server for each user account in an 8-hour period

You can use the Populate from live data feature when you want to check whether contact lookup searches work but you do not
have specific criteria. The BlackBerry Infrastructure and Smartphone Simulator stores information from the email messages that
it receives, and uses this information for contact lookup requests. For example, if the BlackBerry Enterprise Server sends an email
message to Marc Gervais, the simulator stores the name and company, and might later send a contact lookup request using this
information. The BlackBerry Infrastructure and Smartphone Simulator does not require that the email address is associated with
a BlackBerry device user.

You can add specific criteria for contact lookup searches if you want to test a specific issue, such as an odd character set or some
other edge condition.

You cannot specify criteria and populate from live data in one workload profile in one contact lookup request. If you specify even
one text string in a workload profile for a contact lookup request, you must specify all criteria for contact lookup requests.

Adding criteria for contact lookup requests to a workload profile

Use information from email messages for contact lookup searches

Before you begin:

Because the Populate from live data feature uses information from email messages, the workload profile for the BlackBerry®
Infrastructure and Smartphone Simulator must receive email messages.

1. Inthe BlackBerry Infrastructure and Smartphone Simulator, click Options.
2. Select the workload profile that you want to change.
3. Click Edit.
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4.
5.
6.

In the left pane, click Contact Lookup.
Select the Populate values from live data check box.
Click Save until the BlackBerry Infrastructure and Smartphone Simulator displays the main screen.

Specify criteria for contact lookup requests
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In the BlackBerry® Infrastructure and Smartphone Simulator, click Options.

Select the workload profile that you want to change.

Click Edit.

In the left pane, click Contact Lookup.

Verify that the Populate values from live data check box is clear.

Click Add.

In the Field drop-down list, click the type of criteria.

In the Query String field, type the criteria that you want used for the search of the user directory.
Click Save until the BlackBerry Infrastructure and Smartphone Simulator displays the main screen.

Change criteria for contact lookup requests
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In the BlackBerry® Infrastructure and Smartphone Simulator, click Options.

Select the workload profile that you want to change.

Click Edit.

In the left pane, click Contact Lookup.

In the right pane, verify that the Populate values from live data check box is clear.

In the Field drop-down list, click the type of criteria for the contact lookup request.

In the Query String field, type the criteria.

Click Save until the BlackBerry Infrastructure and Smartphone Simulator displays the main screen.

Change the number of contact lookup requests that the BlackBerry
Infrastructure and Smartphone Simulator sends

You can configure the number of contact lookup requests that the BlackBerry® Infrastructure and Smartphone Simulator sends
to the BlackBerry® Enterprise Server during an 8-hour period. If you exceed the maximum permitted value, the BlackBerry
Infrastructure and Smartphone Simulator sets the number to the maximum value.

1.

2.

In the BlackBerry Infrastructure and Smartphone Simulator, click Options.
Select the workload profile that you want to change.
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3. Click Edit.

4. Inthe left pane, click Timers.

5. Click Add.

6. Onthe Contact Lookups line, in the Rate field, type the number of requests that you want the BlackBerry Infrastructure

and Smartphone Simulator to send to the BlackBerry Enterprise Server for each user account in an 8-hour period.
7. Click Save until the BlackBerry Infrastructure and Smartphone Simulator displays the main screen.

Delete criteria for a contact lookup request
The BlackBerry® Infrastructure and Smartphone Simulator removes one line of criteria at a time.

In the BlackBerry Infrastructure and Smartphone Simulator, click Options.
Select the workload profile that you want to change.

Click Edit.

In the left pane, click Contact Lookup.

Click the criteria for contact lookup requests that you want to delete.

Click Remove.
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Click Save until the BlackBerry Infrastructure and Smartphone Simulator displays the main screen.

Remote search for email messages

With BlackBerry® Enterprise Server 5.0 or later, a BlackBerry device user can search through the email messages that are located
on the messaging server instead of the email messages that are stored on the device.

You can simulate the remote search for email messages feature using the this version of the BlackBerry Infrastructure and
Smartphone Simulator.The BlackBerry Infrastructure and Smartphone Simulator requests searches for only one set of fields at a
time (all address fields, the Subject field, or the Body field). The BlackBerry Infrastructure and Smartphone Simulator automatically
completes address fields. You supply the search criteria for the subject and body of the message.

To permit the BlackBerry Infrastructure and Smartphone Simulator to search remote email messages, you must turn on the ability
to search remote email messages on the BlackBerry Enterprise Server. Set the frequency of email message searches in the
BlackBerry Infrastructure and Smartphone Simulator. In environments with IBM® Lotus® Domino® messaging servers, you must
index the email messages on the Lotus Domino messaging servers.

The BlackBerry Infrastructure and Smartphone Simulator logs search requests as part of the statistics and the number of search
requests appears in reports.
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Specify criteria for searching remote email message data

1.
2.
3.
4

In the BlackBerry Infrastructure and Smartphone Simulator, click Options.
Click the name of the workload profile that you want to change. Click Edit.
In the left pane of the profile description, click Remote Email Search.

Inthe Search Field Frequencies section, enter the percentage of times that the BlackBerry Infrastructure and Smartphone
Simulator searches each field. These percentages must add to 100%.

In the More Percentage field, type the percentage of remote email message searches that request searching more of the
message.

In the Retrieval Percentage field, type the percentage of remote email message searches that request to dowload the
message. The percentages in the Request Settings section do not need to total 100%.

In the Subject field or the Body field, perform any of of the following actions:
 Toadd a search string, type the phrase in the Search String field and click Add.
» To delete a search string, click the search string in the list of search strings and click Remove.

Click Save until the BlackBerry Infrastructure and Smartphone Simulator displays the main screen.
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Changing the properties for organizer data

Properties of organizer data synchronization

The BlackBerry® Enterprise Server stores information about organizer data and its synchronization for each BlackBerry device
user. The BlackBerry Infrastructure and Smartphone Simulator checks the configuration information foreach simulated BlackBerry
device. The BlackBerry Infrastructure and Smartphone Simulator sends requests and responses to synchronize organizer data.
Email message filters and email message settings are not organizer data, but they are also synchronized with the BlackBerry
Synchronization Service.

You cannot configure which organizer data is changed, but you can configure the weight of each type. The weights are percentages
that represent the amount of synchronization messages for each type of organizer data. The available types of organizer data
are contacts, notes, tasks, email message filters, and email message settings.

Change the weights of organizer data synchronization

You can change the weights of organizer data payloads for email message settings, email message filters, tasks, notes, and
contacts to determine how many requests for each type of organizer data that the BlackBerry® Infrastructure and Smartphone
Simulator sends. Weights are expressed as a percentage.

1. Inthe BlackBerry Infrastructure and Smartphone Simulator, click Options.
2. Select the workload profile that you want to change.

3. Click Edit.

4. Inthe left pane of the workload profile configuration dialog box, click Sync.
5

Beside the type of record, in the Weight field, type the percentage of synchronization requests that the BlackBerry
Infrastructure and Smartphone Simulator sends.

If necessary, change the weights for other types of records and change lists so that the weights total 100%.
7. Click Save until the BlackBerry Infrastructure and Smartphone Simulator displays the main screen.

Change the number of synchronization requests for organizer data that the
BlackBerry Infrastructure and Smartphone Simulator sends

You can change the number of synchronization requests that the BlackBerry® Infrastructure and Smartphone Simulator sends
for each user in an 8-hour period. If you exceed the maximum permitted value, the BlackBerry Infrastructure and Smartphone
Simulator sets the number of synchronization requests to the maximum value.

1. Inthe BlackBerry Infrastructure and Smartphone Simulator, click Options.
2. Click the workload profile that you want to change.
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sends

Click Edit.

In the left pane of the workload profile dialog box, click Timers.
In the Rate field, type the number of synchronization requests.
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Click Save until the BlackBerry Infrastructure and Smartphone Simulator displays the main screen.
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Changing the properties of a browser simulation

Turn on browsing in a workload profile

The default workload profiles of the BlackBerry® Infrastructure and Smartphone Simulator do not have browsing turned on. You
cannot change the default workload profiles. To turn on browsing for a workload profile, you must add a web address.
In the BlackBerry Infrastructure and Smartphone Simulator, click Options.

Select the workload profile that you want to change.

Click Edit.

In the left pane, click Web Browsing.

Click Add.

For each web address that you want to add, in the URL field, type a web address.

For each web address, in the Weight field, type a weight.

In the left pane, click Timers.
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In the Rate field, type the number of web browsing requests that the BlackBerry Infrastructure and Smartphone Simulator
sends to the BlackBerry® Enterprise Server for each user account in an 8-hour period.

10. Click Save until the BlackBerry Infrastructure and Smartphone Simulator displays the main screen.

Change the number of browser requests that the BlackBerry Infrastructure
and Smartphone Simulator sends

You can change the number of browser requests that the BlackBerry® Infrastructure and Smartphone Simulator sends to the
BlackBerry® Enterprise Server for each user account in an 8-hour period. If you exceed the maximum permitted value, the
BlackBerry Infrastructure and Smartphone Simulator sets the number to the maximum value.

1. Inthe BlackBerry Infrastructure and Smartphone Simulator, click Options.

Select the workload profile that you want to change.

Click Edit.

In the left pane, click Timers.

In the right pane, beside Web Browsing, type the number of requests.

Click Save.

To close the BlackBerry Infrastructure and Smartphone Simulator Options dialog box, click Save.
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Adding or changing web addresses in a workload profile

Add or change web addresses in a workload profile

To test browser requests, the BlackBerry® Infrastructure and Smartphone Simulator sends requests for information from web
sites. The BlackBerry Infrastructure and Smartphone Simulator must be able to access the web addresses that you add, unless
you want to determine how your test environment deals with missing sites.
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In the BlackBerry Infrastructure and Smartphone Simulator, click Options.

Select the workload profile that you want to change.

Click Edit.

To add a web address, click Add.

In the URL field, type the new web address.

In the Weight field, type the percentage of web browsing requests that use this web address.

If necessary, change the weights of other web addresses so that they equal 100%.

Click Save until the BlackBerry Infrastructure and Smartphone Simulator displays the main screen.

Delete a web address from a workload profile
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In the BlackBerry® Infrastructure and Smartphone Simulator, click Options.

Select the workload profile that you want to change.

Click Edit.

Click Web Browsing.

Click the web address that you want to delete.

Click Remove.

If necessary, change the weights of the remaining web addresses so that they equal 100%.

Click Save until the BlackBerry Infrastructure and Smartphone Simulator displays the main screen.
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Configuring support for HTML and rich content email
messages

In the BlackBerry® Performance Engineering Resource Kit, support for HTML and rich content email messages is turned on.

The only option is to turn inline images on or off. By default, inline images in a workload profile are turned on. Inline images that
appear in the first part of an email message might be sent to the simulated BlackBerry devices when support for inline images
is turned off because the BlackBerry® Enterprise Server sends the equivalent of 2KB of plain text from the beginning of each
email message to a BlackBerry device intact. Most inline images are stored in the first part of the message, so the BlackBerry
Enterprise Server sends those images.

All of the simulated devices in the BlackBerry Infrastructure and Smartphone Simulator support HTML and rich content email
messages. If you add user accounts that do not support HTML and rich content email messages while you are testing the wireless
activation process or if you have other devices attached to the BlackBerry Enterprise Server that do not support HTML and rich
content email messages, the BlackBerry Enterprise Server log file contains errors.

Properties of HTML email message display

All simulated BlackBerry® devices have the HTML email format feature turned on.

Property Description

Inline images When the value for this property is True, it specifies that the BlackBerry
Infrastructure and Smartphone Simulator requests inline images for HTML email
messages and rich content email messages that have inline images.

Turn off inline images in HTML email messages

When you turn off inline images in HTML and rich content email messages, the option affects all of the simulated BlackBerry®
devices that use that workload profile.

In the BlackBerry Infrastructure and Smartphone Simulator, click Options.

Click the name of the workload profile that you want to change.

Click Edit.

On the workload profile screen, click Email.

In the Request Inline Images drop-down list, click False.
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Click Save until the BlackBerry Infrastructure and Smartphone Simulator displays the main screen.
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Setting access to network documents from a BlackBerry
device

With a BlackBerry® device running BlackBerry® Device Software 5.0 or later and a BlackBerry® Enterprise Server 5.0 or later, a
BlackBerry device user can exchange files with a network computer. The user can send network access commands that request
a list of files, the properties of a folder or file, or the file. For this test, there must be files in the Remote Dowload folder and in
the Local folder. Any kind of file is acceptable.

You can use the BlackBerry® Performance Engineering Resource Kit to test the exchange of files between a shared network
location and the simulated BlackBerry devices. To test this exchange, you must set up a computer that acts as the network
location. The computer must have the following two folders:

e aRemote Download folder that stores the files that are sent to the simulated BlackBerry devices; this folder must have host
files

e aRemote Upload folder that stores the files that are sent from the simulated devices

The computer that hosts the BlackBerry Infrastructure and Smartphone Simulator must have a folder, the Local folder, that
contains the files that are sent from the simulated BlackBerry devices.

After the BlackBerry Infrastructure and Smartphone Simulator sends the files from the simulated devices to the Remote Upload
Folder, the network computer stores the files in the Remote Upload folder. The BlackBerry Infrastructure and Smartphone
Simulator retrieves the files that are in the Remote Download folder but does not store them after it retrieves them. The files are
not stored on the computer that hosts the BlackBerry Infrastructure and Smartphone Simulator.

Properties of the access to network documents feature

In the BlackBerry® Infrastructure and Smartphone Simulator, the properties that specify access to documents on the network
from the simulated BlackBerry devices are divided into the following sections:

»  the Credentials and Directories section that describes the computer that simulates the network computers
»  theAction Distribution section, which describes the percentage of each type of access request for adocument on the network

Property Description

Username specifies the name of the user account that hosts the network documents
Password specifies the password of the user account that hosts the network documents
Domain specifies the Windows® domain that contains the network documents

Local Folder specifies the name of the folder on the computer that hosts the BlackBerry

Infrastructure and Smartphone Simulator, and which hosts the files that are sent
from the simulated BlackBerry devices
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Property

Remote Download Folder

Remote Upload Folder

Download Percentage

Upload Percentage

List Percentage

Properties Percentage

Set permissions on the shared folder for network access

Description

specifies the name of the computer and the name of the folder for downloaded files
that the BlackBerry Infrastructure and Smartphone Simulator uses as a network
computer, in the form //computername/ path/name

specifies the name of the computer that hosts the Remote Upload Folder and the
name of the folder in the form //computername/path/ name

specifies the percentage of simulated devices that download files from the Remote
Download Folder

specifies the percentage of simulated devices that upload files to the Remote
Upload Folder

specifies the percentage of simulated devices that request a list of folders and files
that are located on the network computer

specifies the percentage of simulated devices that request the properties of a folder
or file that is located on the network computer

Set permissions on the shared folder for network access

The network access feature uses a folder on a separate computer to act as a network computer. The user account that is used to
test network access must have both security permissions and sharing permissions for the folder so that it can create files in and

copy files from the folder.

Click Permissions.

Click OK.
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On the computer that hosts the folder that is used for network access, right-click the folder. Click Properties.
On the Sharing tab, click Share this Folder.

Beside all permissions, select the Allow check boxes.

On the Security tab, click the name of the login account or the group containing the user account that the BlackBerry®

Infrastructure and Smartphone Simulator uses to test network access.

7. Beside the following permissions, select the Allow check boxes:

e Full Control
e Modify
* Read & Execute

 List Folder Contents

* Read
e Write

8. Click OK.
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Configure access to network documents in the BlackBerry Infrastructure and
Smartphone Simulator
Each workload profile in the BlackBerry® Infrastructure and Smartphone Simulator can be pointed at a different Remote Upload

Folder and Remote Download Folder. Larger or smaller network documents change the workload associated with access to
network documents.

Before you begin: Verify that the network computer in the test environment hosts the Remote Upload Folder and the Remote
Download Folder.
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In the BlackBerry Infrastructure and Smartphone Simulator, click Options.

Click the name of the workload profile that you want to change. Click Edit.

In the Workload Profile Configuration dialog box, in the left pane, click Remote Desktop.
Type the login information for the user account on the network computer

In the Domain field, type the name of the domain.

In the Local Folder field, type the name of the folder that stores the files that the simulated BlackBerry devices send to the
network computer.

In the Remote Download Folder field, type the name of the folder on the network computer that hosts the documents that
the simulated BlackBerry devices download.

In the Remote Upload Folder field, type the name of the folder on the network computer that hosts the documents that
the simulated BlackBerry devices upload.

To verify that the information is correct, click Test Remote Connection.
Inthe Action Distribution section, configure the percentage of simulated devices that send each network access command.
Click Save until the BlackBerry Infrastructure and Smartphone Simulator displays the main screen.
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Changing the models of BlackBerry devices that the
BlackBerry Infrastructure and Smartphone Simulator
simulates

BlackBerry device models and screen resolutions

You can configure the BlackBerry® Infrastructure and Smartphone Simulator to send messages from three different models of
the BlackBerry device. In the simulation that the BlackBerry Infrastructure and Smartphone Simulator creates, the models differ
in screen resolution. Each simulated model of the BlackBerry device has a different screen resolution.

The BlackBerry® Enterprise Server uses the screen resolution only in some situations. The BlackBerry Infrastructure and
Smartphone Simulator sends a screen resolution whenever it requests a picture that was not created for a BlackBerry device
model. The BlackBerry Enterprise Server component uses the screen resolution to scale and render the image correctly.

The BlackBerry Infrastructure and Smartphone Simulator sends a screen resolution with HTTP requests and attachment requests.
Those are the only requests that require the information about BlackBerry device models. You must configure the BlackBerry
device model only ifyour testenvironmentincludes the BlackBerry Attachment Service or the BlackBerry MDS Connection Service.

The percentage of each BlackBerry device model is called its weight. By default, the BlackBerry Infrastructure and Smartphone
Simulator sends 100% of all messages as if they were from BlackBerry® 8300 smartphones.

Installing a BlackBerry device to work with the BlackBerry Infrastructure and
Smartphone Simulator

In a typical test environment, the BlackBerry® Infrastructure and Smartphone Simulator simulates all BlackBerry devices.
However, when you test a BlackBerry® Enterprise Server, you might want to send information that the BlackBerry Infrastructure
and Smartphone Simulator does not generate. You can use a physical BlackBerry device or a simulated BlackBerry device to send
information.

You can associate a BlackBerry device or a simulated BlackBerry device with a BlackBerry device user account on the BlackBerry
Enterprise Server that you are using for performance testing. You can install the BlackBerry device before or after you install the
other BlackBerry device user accounts on the BlackBerry Enterprise Server. Because the BlackBerry device is in a cradle, the
BlackBerry device sends messages directly to the BlackBerry Enterprise Server and bypasses the BlackBerry Infrastructure and
Smartphone Simulator.

The BlackBerry Infrastructure and Smartphone Simulator does not record any information that you send to the BlackBerry
Enterprise Server using this BlackBerry device. If you configure logging options correctly, the BlackBerry Enterprise Server can
log the information that you send using the physical BlackBerry device.
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Configuring device weights

To simulate the BlackBerry® device models that the BlackBerry Infrastructure and Smartphone Simulator simulates for a specific
workload profile, you must change the BlackBerry device configuration in that workload profile.

In the BlackBerry Infrastructure and Smartphone Simulator, click Options.

Open a workload profile.

Click Edit.

In the left pane, click Devices.

Beside the name of each BlackBerry device model, type a new weight. The total weight must equal 100%.

Click Save until the main screen of the simulator appears.

NG IFNTTIS SR

59



Administration Guide Creating reports about a test

Creating reports about a test

View statistics about the current test

Each testis associated with a BlackBerry® Enterprise Server and a workload profile, and determines the workload using the values
in the workload profile. The BlackBerry® Infrastructure and Smartphone Simulator displays the values for the current test on the
Statistics tab. In the BlackBerry Infrastructure and Smartphone Simulator, statistic names are organized in a tree-like structure.

1. Inthe BlackBerry Infrastructure and Smartphone Simulator, click the Statistics tab.
2. Click the item that you want to see statistics for.

Generate a BlackBerry Infrastructure and Smartphone Simulator report

You can save the current statistics asan HTML file at any time so that you have a record of the progress of the test. The BlackBerry®
Infrastructure and Smartphone Simulator saves the statistics as a file in the Reports folder, with the name
BBISSimReport<yyyymmdd>-<hhmmss>html, where <yyyymmdd> is the current date and <hhmmss> is the current time.

In the BlackBerry Infrastructure and Smartphone Simulator, click Simulation > Generate HTML Report.

View a BlackBerry Infrastructure and Smartphone Simulator report

You can view a report of the BlackBerry® Infrastructure and Smartphone Simulator statistics in a browser instead of saving the
statistics as an HTML file.

In the BlackBerry Infrastructure and Smartphone Simulator, click Simulation >View HTML Report.

Interpreting a BlackBerry Infrastructure and Smartphone Simulator report

When reading and interpreting a report that the BlackBerry® Infrastructure and Smartphone Simulator creates, consider the
following:

e The information in a report is relative to the BlackBerry Infrastructure and Smartphone Simulator. In a report, the term
"sent" refers to the information that the BlackBerry Infrastructure and Smartphone Simulator sends, and the term "received"
refers to the information that the BlackBerry Infrastructure and Smartphone Simulator receives.

e Areportincludes entries for compressed bytes and uncompressed bytes that were sent until the time that the report was
generated. These entries show the number of bytes of compressed information and the number of bytes that the compressed
information expands to. A comparison of these two numbers can reveal that the BlackBerry Infrastructure and Smartphone
Simulator or the BlackBerry® Enterprise Server is not sending enough information, which might not be apparent from the
compressed values alone.
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Troubleshooting

Best practice: Troubleshooting a BlackBerry Performance Engineering
Resource Kit test environment

Consider the following guidelines:

e Verify that your test environment is in a single Windows® domain.
e Verify that your test environment is in a single BlackBerry® Domain .
e Isolate components of the test environment by installing them at different times and testing the installations.
e Add components one at a time until an issue appears.
e Before you add a component, verify that the performance monitor for the computer is turned on.
e Add components in the following order:
e messaging server
«  load generator for the messaging server
e basic BlackBerry® Enterprise Server configuration, including the BlackBerry Configuration Database
e BlackBerry Load Test Configuration Tool
e BlackBerry Infrastructure and Smartphone Simulator
e additional BlackBerry Enterprise Server components
e additional components that do not belong to the BlackBerry Enterprise Server
e Check all running components for issues, because the source of an issue is sometimes not in the component that reports

the issue. For example, the BlackBerry Load Test Configuration Tool generates an error message if it cannot open a SOAP
connection, but the issue is typically in the network or web service.

| get permission errors when | try to install BlackBerry Enterprise Server 5.0

Description

During the BlackBerry® Enterprise Server 5.0 installation process, you receive a Preinstall Checklist warning, "The setup
application cannot find the Send As permission for account <Domain\User>".

For the BlackBerry® Enterprise Server for Microsoft® Exchange to work correctly, the BlackBerry service account must have the
Send As permission for the user object in Microsoft® Active Directory®. The prerequisite check in the setup application verifies
whether this permission is configured for all User Objects in Microsoft Active Directory.

Possible solution

You must use an administrator account to configure the correct permissions in Microsoft® Exchange.

1. Open Start > Microsoft Exchange > Active Directory Users and Computers.
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On the View menu, verify that the Advanced Features option is selected.
Right-click the Windows® domain. Click Properties.

On the Security tab, click Advanced.

Add the account that requires the Send As permission (for example, BESAdmin).
Double-click the account.

In the Allow column, click Edit.

In the Apply onto drop-down list, click User Objects.

At the bottom of the page, in the Allow column, check Send As.
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Unable to get user information from the address book for user

Possible cause

Inan IBM® Lotus® Domino® environment, the BlackBerry® Enterprise Server cannot find the user account. This message appears
in the BlackBerry Enterprise Server log file when the local copy of the user directory is out of date.

Possible solution

On the computer that hosts a command console for the IBM Lotus Domino server, type pull <messaging_server_name>.

| get GME errors in the BlackBerry Enterprise Server log files

Possible cause

The BlackBerry® Messaging Agent might not be running or might be renamed. Until the BlackBerry Messaging Agent starts
again, the BlackBerry® Enterprise Server writes GME errors in the log files and does not send email messages. The BlackBerry
Manager or BlackBerry Administration Service displays the status of BlackBerry device users as Initialize.

Possible solution
1. Ifthe BlackBerry Messaging Agent is running, stop it.
2. Start the BlackBerry Messaging Agent again using the correct name.

| get a MAPI error message when the BlackBerry Enterprise Server performs
a calendar lookup in Microsoft Exchange 2007

Description

When the BlackBerry® Enterprise Server looks up calendar information in Microsoft® Exchange 2007, the BlackBerry Messaging
Agent (MAGT) log file contains a MAPI error message if public folders are not present.
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Microsoft Exchange 2007 can be installed without public folders for environments with Microsoft® Outlook® 2007 and later as
the messaging application; however, Microsoft Outlook and the BlackBerry Enterprise Server require access to public folders.

Possible solution

Create a public folder storage group and database on the Microsoft Exchange server.

Error messages: BlackBerry Load Test Configuration Tool

Calendar validation failure
This message appears when, after the BlackBerry® Load Test Configuration Tool converts the user account, the BlackBerry
Configuration Database value in the Calendar enabled field is not typed correctly.

Device capabilities validation failure for PIN
This message appears when the value of the Device Capabilities field selected in the BlackBerry Load Test Configuration
Tool does not match the corresponding value stored in the BlackBerry Configuration Database.

DeviceType validation failure
This message appears when the Device Type field in the BlackBerry Configuration Database is not specified correctly.

DispatcherHostInstance not found
This message appears when the BlackBerry Load Test Configuration Tool cannot find an instance of the BlackBerry Dispatcher
service on the computer that the BlackBerry Load Test Configuration Tool is installed on.

Email address contains an invalid character

This message appears when an email address that is provided in the file that contains the user account list contains a
character that is not valid.

Encryption key validation failure

This message appears when the encryption key that the BlackBerry Load Test Configuration Tool uses is different from the
encryption key that is stored in the BlackBerry Configuration Database.

ERROR: Additional Device Capabilities field length invalid: <length>
This message appears when the length of the record field in the BlackBerry Configuration Database entry does not correspond
with the length that was specified. The BlackBerry device capabilities were not specified correctly.

ERROR: Device Capabilities length invalid: <length>
This message appears when the length of the record field in the BlackBerry Load Test Configuration Tool entry does not
correspond with the length that was specified, for a reason other than an incorrect definition of the capabilities that the user
can specify.

ERROR: Dispatcher or ConfigServerName registry entries missing.

This message appears when the registry on the computer is missing the values that describe the BlackBerry Dispatcher and
the BlackBerry® Enterprise Server.
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ERROR: Failed to parse!!
This message appears when the BlackBerry Enterprise Server does not specify any capabilities for a user account.

ERROR: Not implemented
This message appears when the BlackBerry Load Test Configuration Tool tries to activate a user account, but the type of
messaging server is not specified for the user account.

ERROR: PIN is not available
This message appears when the PIN that is associated with the user account that the BlackBerry Load Test Configuration
Tool is trying to convert is already reserved by another user account.

ERROR: User <email_address> has pending delete status
This message appears when the user accountis still pending deletion on the BlackBerry Enterprise Server when the BlackBerry
Load Test Configuration Tool tries to convert or update the user account.

Error parsing <user_account_list_entry>
This message appears when the BlackBerry Load Test Configuration Tool cannot parse an entry in the user accounts list.
This error message is usually preceded by a descriptive error message of the issue.

EXPECTED: email@server.com, Flxxooxx
This message occurs when the format of the user account file is not correct. The error messages shows the correct format
for entry for the user account list, and is also stored in the log.

Failed to connect to socket: <socket_name>

This message appears when the BlackBerry Load Test Configuration Tool cannot connect to a socket when the BlackBerry
Load Test Configuration Tool tries to start a web service.

MailStoreName not updated <PIN>

This message appears in a test environment with BlackBerry® Enterprise Server for IBM® Lotus® Domino® when the
BlackBerry Load Test Configuration Tool tries to verify user accounts, but the field MailStoreDisplayName is not current in
the BlackBerry Configuration Database. The BlackBerry Load Test Configuration Tool adds user accounts to the BlackBerry
Enterprise Server for IBM Lotus Domino in chunks of 200 user accounts, with a delay between each chunk. After each delay,
the BlackBerry Load Test Configuration Tool updates the information in the MailStoreDisplayName field of the BlackBerry
Configuration Database. If the process of adding user accounts takes longer than the delay programmed into the BlackBerry
Load Test Configuration Tool, the BlackBerry Load Test Configuration Tool displays this message.

MailStoreType was not found
This message appears when the BlackBerry Configuration Database does not specify the type of messaging server.

One or more of the failed user accounts are pending for deletion or could not be reimported. Writing user accounts

to email-to-pin map file
This message appears in a test environment with BlackBerry® Enterprise Server for IBM® Lotus® Domino® when you cancel
the delay of the BlackBerry Load Test Configuration Tool and you are converting user accounts again. The BlackBerry Load
Test Configuration Tool writes to a file a list of the user accounts that it did not convert.

64



Administration Guide Error messages: BlackBerry Load Test Configuration Tool

OTAFM validation failure
This message appears when the OTAFM enabled field in the BlackBerry Configuration Database is not typed correctly.

Specified email address is invalid
This message appears when an email address in the file that contains the user account list has a format that is not valid.

Specified PIN is invalid
This message appears when a PIN in the user account list is not eight characters long.

The remove name could not be resolved
This message appears when the name of the BlackBerry Administration Service is different from the name that you specified.

The specified user import file not found
This message appears when the file that contains the user account list does not exist on the computer that the BlackBerry
Load Test Configuration Tool is installed on.

Timeout waiting for pending user updates...
This message appears when the BlackBerry Load Test Configuration Tool waits more than 300 seconds for the BlackBerry
Enterprise Server to complete pending changes.

Unable to determine BES Dispatcher instance. Try specifying -bdn <server> option from the command line
This message appears when the BlackBerry Load Test Configuration Tool is setting up a web service and cannot retrieve the
name of the BlackBerry Dispatcher instance in the registry or the command line.

User <user_name> could not be deleted
This message appears when the BlackBerry Load Test Configuration Tool cannot delete a user account. When the BlackBerry
Load Test Configuration Tool converts user accounts again, the user accounts are deleted from the BlackBerry Enterprise
Server and then are added to the BlackBerry Enterprise Server.

User <user_name> could not be disabled
This message appears when the BlackBerry Administration Service could not deactivate a user account.

User '<user_name>' already exists. Updates are not supported in Domino. The user must be deleted in BAS/
BBManager before importing...
This message appears when you left the user account named <user_name> on that particular BlackBerry Enterprise Server
for IBM Lotus Domino. For this environment, you must delete the user accounts from the BlackBerry Enterprise Server before
running the BlackBerry Load Test Configuration Tool.

User '<user_name>' is disabled in BAS. (BASID: <BAS_user_ID> UserConfigID: <user_config_ID>) The user must
be enabled or deleted in BAS/BBManager before importing...
This message appears when a user account exists on the BlackBerry Enterprise Server for IBM Lotus Domino but is not
associated with it.

User '<user_name>' was not found in BAS. (BASID: <BAS_user_ID> UserConfigID: <user_config_ID>)
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This message appears when a user account does not exist in the BlackBerry Administration Service.

UserDeleteStatus validation failure

This message appears when the BlackBerry Enterprise Server for IBM Lotus Domino has scheduled a converted user account
for deletion during the conversion validation process.

Validation Failed.. <user_name>, <PIN>

This message appears when the BlackBerry Load Test Configuration Tool cannot validate a user account that was just
converted.

Error messages: relayed by BlackBerry Load Test Configuration Tool
The following error messages are reported by the BlackBerry® Load Test Configuration Tool but occur elsewhere.

Database Connection Failed <error_number>

This message appears when the connection between the BlackBerry Load Test Configuration Tool and the BlackBerry
Configuration Database ends unexpectedly, where error_numberis the number of the most recent error. The number might
not indicate the source of the issue.

Error: <create_user_message>

This message appears when the user account could not be created on the BlackBerry Administration Service, where
<create_user_message> describes the issue in more detail.

ERROR: createUserCompletedEventHandler [ <add_user_error_number> ]

This message appears when a program cannot work when the BlackBerry Load Test Configuration Tool tries to add a user
account to the BlackBerry® Enterprise Server version 5.0 or later, where the <add_user_error_number> specifies the
BlackBerry Enterprise Server error message that describes the issue.

Environment Detection Failed <error_number>

This message appears when information is missing when the BlackBerry Load Test Configuration Tool tries to determine the
environment information, where the number specifies the error message that describes the missing information.

Error occurred: <find_services_instance_message>

This message appears when a program cannot work when the BlackBerry Load Test Configuration Tool is attempting to
obtain a specified BlackBerry Dispatcher service, where <find_services_instance_message > describes the reason.

Error occurred: <find_services_message>

Thismessage appearswhen a program failed when the BlackBerry Load Test Configuration Tool tried to retrieve the BlackBerry
Dispatcher service with a specified name, where <find_services_message> describes the reason.

Error occurred: <get_user_attributes_message>

This message appears when a program generates an issue when the BlackBerry Load Test Configuration Tool tries to retrieve
information about a specific BlackBerry Administration Service user account.
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Failed to establish BAS web service connection
The BlackBerry Load Test Configuration Tool cannot establish a web service. This usually happens if the type of messaging
server (one of exchange, domino, or groupwise) is not specified in the registry or BlackBerry Configuration Database.

Failed to establish web service connection: <error_message>
This message appears when a program generates an error message while the BlackBerry Load Test Configuration Tool tries
to establish a connection, where the <error_message> describes the reason.

Failed to open Database connection
This message appears when the BlackBerry Load Test Configuration Tool cannot connect with the specified BlackBerry
Configuration Database.

Finduser accounts: Query failed: <find_mail_store_user_message>
This message appears when an issue arises when the BlackBerry Load Test Configuration Tool is querying the BlackBerry
Administration Service for the name of the messaging server for the specified user account, where
<find_mail_store_user_message> describes the reason.

Finduser accounts: User '<email_address>' was not found in GAL.
This message appears when the query for the name of the messaging server for this user account is successful but the user
account is not in the user directory.

GetUser: '<email_address>' not found
This message appears when the email address specified for the user account does not exist on the BlackBerry Administration
Service in the test environment.

Invalid device capabilities (wrong header): <PIN>
This message appears when the description of the BlackBerry device capabilities for a PIN has a header that does not begin
with the correct number.

Please contact your administrator to ensure you have the proper MAPI Permissions to Add user accounts
This message appears when user account that is logged into the BlackBerry Enterprise Server for Microsoft® Exchange does
not have the MAPI permissions to add user accounts to Microsoft® Exchange.

Please ensure that the BAS service is running and the BAA plug-in is installed
This message appears when the BlackBerry Administration Service is not running or the BlackBerry® Administration API
plug-in is not installed. This message occurs in the log.

The BlackBerry Load Test Configuration Tool cannot convert user accounts

Possible cause

If the BlackBerry® Enterprise Server for Microsoft® Exchange has multiple MAPI profiles, the MAPI profile that was selected
using the BlackBerry Load Test Configuration Tool was not the correct one.

Possible solution
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Try clearing the Microsoft® Exchange cache and selecting a different MAPI profile for the BlackBerry Load Test Configuration Tool.

BlackBerry Enterprise Server does not have the correct number of user
accounts

Possible cause
An entry in the user account list is not formatted correctly.
Possible solution

1. Inthe BlackBerry® Enterprise Server, delete the user account that is formatted incorrectly.

2. Delete all user accounts that are associated with a PIN that is higher than the PIN of the user account that you deleted in
step 1.

3. Add the user accounts again. Make sure to include a fully qualified email address and that PINs are used consistently in
the user account list.

4. Run the BlackBerry Load Test Configuration Tool again.

Verify the number of user accounts that you converted for the BlackBerry Infrastructure and
Smartphone Simulator

You can use the BlackBerry® Infrastructure and Smartphone Simulator to verify the number of user accounts that are associated
with the BlackBerry® Enterprise Server.

1. Inthe BlackBerry Infrastructure and Smartphone Simulator, click Options.

2. Onthe left pane of the BlackBerry Infrastructure and Smartphone Simulator Settings dialog box, in the tree, click
Server Configuration.

3. Intheright pane of the BlackBerry Infrastructure and Smartphone Simulator Settings dialog box, in the Clients drop-
down list, click a BlackBerry Enterprise Server name.

4. In the left pane of the BlackBerry Infrastructure and Smartphone Simulator Settings dialog box, click Users.
The number of users is displayed in the lower right corner of the dialog box.
5. Perform one of the following actions:

e Ifthe number of user accounts displayed in the lower right corner of the dialog box is the same as the number that
you converted using the BlackBerry Load Test Configuration Tool, click Close.

e Ifthe number of user accounts is different from the number that you converted using the BlackBerry Load Test
Configuration Tool, click Refresh. The correct number of user accounts should appear on the screen.

6. Toclose the Options dialog box, click Cancel.
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Error messages: BlackBerry Infrastructure and Smartphone Simulator

Failure to initialize
This message appears when the installation of the BlackBerry® Infrastructure and Smartphone Simulator was not completed.

Application configuration problem

This message appears if you do not install the Microsoft® Visual C++® 2005 SP1 Redistribution Pack or the Microsoft® .NET
Framework 2.0.

Unable to find configuration database

This message appears when the BlackBerry Infrastructure and Smartphone Simulator cannot locate the BlackBerry
Configuration Database, when the BlackBerry Configuration Database is not installed in the test environment, or the
computer that hosts the BlackBerry Configuration Database is unavailable.

The BlackBerry Infrastructure and Smartphone Simulator does not connect
to the BlackBerry Enterprise Server
Description

The BlackBerry® Enterprise Server opens the connection to the BlackBerry Infrastructure and Smartphone Simulator. If the
BlackBerry Infrastructure and Smartphone Simulator is not running, the BlackBerry Enterprise Server cannot open the connection
and tries again after a period of time.

Possible solution
To force a connection manually, try performing the following actions:

1. Onthe computer that hosts the BlackBerry Enterprise Server, stop the BlackBerry Enterprise Server services.

2. Onthe computer that hosts the BlackBerry Infrastructure and Smartphone Simulator, start the BlackBerry Infrastructure
and Smartphone Simulator.

3. Onthe computer that hosts the BlackBerry Enterprise Server, start the BlackBerry Enterprise Server services.

BlackBerry Enterprise Server disconnects

Possible cause

If the status of the BlackBerry® Enterprise Server is showing as Disconnected, the possible cause might be that too much time
passed since the BlackBerry Infrastructure and Smartphone Simulator communicated with the BlackBerry Enterprise Server. If

the BlackBerry Infrastructure and Smartphone Simulator does not respond, the BlackBerry Enterprise Server waits before it tries
connecting again.
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If the status of the BlackBerry Enterprise Server is showing as Disconnected, the possible cause might be that too much time
passed since the BBISS communicated with the BlackBerry Enterprise Server. If the BlackBerry Infrastructure and Smartphone
Simulator does not respond, the BlackBerry Enterprise Server waits before it tries connecting again.

Possible solution

To force the BlackBerry Enterprise Server to reconnect to the BlackBerry Infrastructure and Smartphone Simulator, stop and
restart the BlackBerry Enterprise Server components.

Changes to the BlackBerry Enterprise Server are not reflected in the
BlackBerry Infrastructure and Smartphone Simulator

Possible cause
The BlackBerry® Enterprise Server was changed while the BlackBerry Infrastructure and Smartphone Simulator was running.
Possible solution

Stop the BlackBerry Infrastructure and Smartphone Simulator and the BlackBerry® Enterprise Server and restart them in that
order.

Remove the BlackBerry Performance Engineering Resource Kit

1. On the computer that hosts the BlackBerry® Load Test Configuration Tool, on the taskbar, click Settings > Control Panel
>Add or Remove Programs.

Click BlackBerry Load Test Configuration Tool.
Click Remove.
Click OK.

On the computer that hosts the BlackBerry Infrastructure and Smartphone Simulator, on the taskbar, click Settings >
Control Panel > Add or Remove Programs.

Click BlackBerry Infrastructure and Smartphone Simulator.
Click Remove.
Click OK.

Using the administrative tools of the BlackBerry® Enterprise Server, remove the user accounts from the BlackBerry Enterprise
Server.
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RIM proprietary protocols

Protocol
ALP

CICAL

CMIME

DFTP

GME

IPPP

OTAFM

OTAKEYGEN

Service Book protocol

SRP

SYNC

RIM proprietary protocols

Description

The address lookup (ALP) protocol is a protocol that allows the transfer of contact lookup requests
and the results between the BlackBerry® device and the appropriate destination device.

The compressed Internet calendar (CICAL) protocol is a protocol that allows the transfer of calendar
appointments back and forth between the appropriate destination service and the BlackBerry
device. Meetings are sent using the email (CMIME) protocol.

The compressed Multipurpose Internet Mail Extension (CMIME) protocol is a protocol that allows
the transfer of email messages back and forth between the appropriate destination service and
the BlackBerry device.

The device file transfer (DFTP) protocol is a protocol that allows the BlackBerry device to exchange
files with the local area network of the BlackBerry® Enterprise Server.

The gateway message envelope (GME) protocol is a protocol that allows the transfer of compressed
and encrypted data between the wireless network and BlackBerry devices. The protocol defines a
routing layer that specifies the types of message contents allowed and the addressing information
forthe data. Gateways and routing components use this information to identify the type and source
of the BlackBerry device data, and the appropriate destination service to route the data to.

The IP proxy protocol (IPPP) is a protocol that allows the transfer of both TCP and HTTP packets
between the appropriate destination service and the BlackBerry device.

The Over The Air Folder Management (OTAFM) protocol is a protocol that allows the user of a
BlackBerry device to create and delete email message folders and to move messages between
folders on a BlackBerry device or the appropriate destination service and have the changes
performed on the other.

The wireless key generation (OTAKEYGEN) protocol is a protocol that allows the activation of users
over the wireless network, between the appropriate destination service and the BlackBerry device.
The Service Book Protocol is a protocol that allows the transfer of service book information between
the BlackBerry Enterprise Server and the BlackBerry device.

The Server Routing Protocol is responsible for communication between the BlackBerry Enterprise
Server and the BlackBerry® Infrastructure .

The synchronization (SYNC) protocol is a protocol that allows the transfer of packets containing
organizer data, data changes, email message filters and email message signatures between the
BlackBerry device and the BlackBerry Synchronization Service of the BlackBerry Enterprise Server.
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Glossary

BlackBerry Domain

ABlackBerry Domain consists of the BlackBerry Configuration Database with its users and any BlackBerry® Enterprise Server
instances that connect to it.

BlackBerry MDS
BlackBerry® Mobile Data System

messaging server

Amessaging server sends and processes messages and provides collaboration services, such as updating and communicating
calendar and address book information.

MFH
message from handheld

MTH
message to handheld

PIM
personal information management

PIN
personal identification number

SOAP
Simple Object Access Protocol

uiD
unique identifier
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To provide feedback on this deliverable, visit www.blackberry.com/docsfeedback.
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Legal notice

©2010 Research In Motion Limited. All rights reserved. BlackBerry®, RIM®, Research In Motion®, SureType®, SurePress™ and
related trademarks, names, and logos are the property of Research In Motion Limited and are registered and/or used in the U.S.
and countries around the world.

Domino, IBM, and Lotus are trademarks of International Business Machines Corporation. Microsoft, Active Directory, SQL Server,
Visual C++, and Windows Server are trademarks of Microsoft Corporation. Novell and GroupWise are trademarks of Novell, Inc.
All other trademarks are the property of their respective owners.

This documentation including all documentation incorporated by reference herein such as documentation provided or made
available at www.blackberry.com/go/docs is provided or made accessible "AS IS" and "AS AVAILABLE" and without condition,
endorsement, guarantee, representation, or warranty of any kind by Research In Motion Limited and its affiliated companies
("RIM") and RIM assumes no responsibility for any typographical, technical, or other inaccuracies, errors, or omissions in this
documentation. In order to protect RIM proprietary and confidential information and/or trade secrets, this documentation may
describe some aspects of RIM technology in generalized terms. RIM reserves the right to periodically change information that
is contained in this documentation; however, RIM makes no commitment to provide any such changes, updates, enhancements,
or other additions to this documentation to you in a timely manner or at all.

This documentation might contain references to third-party sources of information, hardware or software, products or services
including components and content such as content protected by copyright and/or third-party web sites (collectively the "Third
Party Products and Services"). RIM does not control, and is not responsible for, any Third Party Products and Services including,
without limitation the content, accuracy, copyright compliance, compatibility, performance, trustworthiness, legality, decency,

links, or any other aspect of Third Party Products and Services. The inclusion of a reference to Third Party Products and Services
in this documentation does not imply endorsement by RIM of the Third Party Products and Services or the third party in any way.

EXCEPT TO THE EXTENT SPECIFICALLY PROHIBITED BY APPLICABLE LAW IN YOUR JURISDICTION, ALL CONDITIONS,
ENDORSEMENTS, GUARANTEES, REPRESENTATIONS, OR WARRANTIES OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING
WITHOUT LIMITATION, ANY CONDITIONS, ENDORSEMENTS, GUARANTEES, REPRESENTATIONS OR WARRANTIES OF
DURABILITY, FITNESS FOR A PARTICULAR PURPOSE OR USE, MERCHANTABILITY, MERCHANTABLE QUALITY, NON-
INFRINGEMENT, SATISFACTORY QUALITY, ORTITLE, ORARISING FROM A STATUTE OR CUSTOM ORA COURSE OF DEALING
OR USAGE OF TRADE, OR RELATED TO THE DOCUMENTATION OR ITS USE, OR PERFORMANCE OR NON-PERFORMANCE
OF ANY SOFTWARE, HARDWARE, SERVICE, OR ANY THIRD PARTY PRODUCTS AND SERVICES REFERENCED HEREIN, ARE
HEREBY EXCLUDED. YOU MAY ALSO HAVE OTHER RIGHTS THAT VARY BY STATE OR PROVINCE. SOME JURISDICTIONS
MAY NOT ALLOW THE EXCLUSION OR LIMITATION OF IMPLIED WARRANTIES AND CONDITIONS. TO THE EXTENT
PERMITTED BY LAW, ANY IMPLIED WARRANTIES OR CONDITIONS RELATING TO THE DOCUMENTATION TO THE EXTENT
THEY CANNOT BE EXCLUDED AS SET OUT ABOVE, BUT CAN BE LIMITED, ARE HEREBY LIMITED TO NINETY (90) DAYS FROM
THE DATE YOU FIRST ACQUIRED THE DOCUMENTATION OR THE ITEM THAT IS THE SUBJECT OF THE CLAIM.

TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW IN YOUR JURISDICTION, IN NO EVENT SHALL RIM BE LIABLE
FOR ANY TYPE OF DAMAGES RELATED TO THIS DOCUMENTATION OR ITS USE, OR PERFORMANCE OR NON-

PERFORMANCE OF ANY SOFTWARE, HARDWARE, SERVICE, OR ANY THIRD PARTY PRODUCTS AND SERVICES REFERENCED
HEREIN INCLUDING WITHOUT LIMITATION ANY OF THE FOLLOWING DAMAGES: DIRECT, CONSEQUENTIAL, EXEMPLARY,
INCIDENTAL, INDIRECT, SPECIAL, PUNITIVE, OR AGGRAVATED DAMAGES, DAMAGES FOR LOSS OF PROFITS OR REVENUES,
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FAILURE TO REALIZE ANY EXPECTED SAVINGS, BUSINESS INTERRUPTION, LOSS OF BUSINESS INFORMATION, LOSS OF
BUSINESS OPPORTUNITY,OR CORRUPTION OR LOSS OF DATA, FAILURESTO TRANSMIT ORRECEIVEANY DATA, PROBLEMS
ASSOCIATED WITH ANY APPLICATIONS USED IN CONJUNCTION WITH RIM PRODUCTS OR SERVICES, DOWNTIME COSTS,
LOSS OF THE USE OF RIM PRODUCTS OR SERVICES OR ANY PORTION THEREOF OR OF ANY AIRTIME SERVICES, COST OF
SUBSTITUTE GOODS, COSTS OF COVER, FACILITIES OR SERVICES, COST OF CAPITAL, OR OTHER SIMILAR PECUNIARY
LOSSES, WHETHER OR NOT SUCH DAMAGES WERE FORESEEN OR UNFORESEEN, AND EVEN IF RIM HAS BEEN ADVISED
OF THE POSSIBILITY OF SUCH DAMAGES.

TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW IN YOUR JURISDICTION, RIM SHALL HAVE NO OTHER
OBLIGATION, DUTY, OR LIABILITY WHATSOEVER IN CONTRACT, TORT, OR OTHERWISE TO YOU INCLUDING ANY LIABILITY
FOR NEGLIGENCE OR STRICT LIABILITY.

THE LIMITATIONS, EXCLUSIONS, AND DISCLAIMERS HEREIN SHALL APPLY: (A) IRRESPECTIVE OF THE NATURE OF THE
CAUSE OFACTION, DEMAND, ORACTION BYYOU INCLUDING BUTNOT LIMITED TO BREACH OF CONTRACT, NEGLIGENCE,
TORT, STRICT LIABILITY OR ANY OTHER LEGAL THEORY AND SHALL SURVIVE A FUNDAMENTAL BREACH OR BREACHES
OR THE FAILURE OF THE ESSENTIAL PURPOSE OF THIS AGREEMENT OR OF ANY REMEDY CONTAINED HEREIN; AND (B)
TO RIM AND ITS AFFILIATED COMPANIES, THEIR SUCCESSORS, ASSIGNS, AGENTS, SUPPLIERS (INCLUDING AIRTIME
SERVICE PROVIDERS), AUTHORIZED RIM DISTRIBUTORS (ALSO INCLUDING AIRTIME SERVICE PROVIDERS) AND THEIR
RESPECTIVE DIRECTORS, EMPLOYEES, AND INDEPENDENT CONTRACTORS.

IN ADDITION TO THE LIMITATIONS AND EXCLUSIONS SET OUT ABOVE, IN NO EVENT SHALL ANY DIRECTOR, EMPLOYEE,
AGENT, DISTRIBUTOR, SUPPLIER, INDEPENDENT CONTRACTOR OF RIM OR ANY AFFILIATES OF RIM HAVE ANY LIABILITY
ARISING FROM OR RELATED TO THE DOCUMENTATION.

Prior to subscribing for, installing, or using any Third Party Products and Services, it is your responsibility to ensure that your
airtime service provider hasagreed to supportall of their features. Some airtime service providers might not offer Internet browsing
functionality with a subscription to the BlackBerry® Internet Service. Check with your service provider for availability, roaming
arrangements, service plans and features. Installation or use of Third Party Products and Services with RIM's products and services
may require one or more patent, trademark, copyright, or other licenses in order to avoid infringement or violation of third party
rights. You are solely responsible for determining whether to use Third Party Products and Services and if any third party licenses
are required to do so. If required you are responsible for acquiring them. You should not install or use Third Party Products and
Services until all necessary licenses have been acquired. Any Third Party Products and Services that are provided with RIM's
products and services are provided as a convenience to you and are provided "AS IS" with no express or implied conditions,
endorsements, guarantees, representations, or warranties of any kind by RIM and RIM assumes no liability whatsoever, in relation
thereto. Your use of Third Party Products and Services shall be governed by and subject to you agreeing to the terms of separate
licenses and other agreements applicable thereto with third parties, except to the extent expressly covered by a license or other
agreement with RIM.

Certainfeatures outlined in this documentation require a minimum version of BlackBerry® Enterprise Server, BlackBerry® Desktop
Software, and/or BlackBerry® Device Software.

The terms of use of any RIM product or service are set out in a separate license or other agreement with RIM applicable thereto.
NOTHINGINTHIS DOCUMENTATION IS INTENDED TO SUPERSEDE ANY EXPRESS WRITTEN AGREEMENTS OR WARRANTIES
PROVIDED BY RIM FOR PORTIONS OF ANY RIM PRODUCT OR SERVICE OTHER THAN THIS DOCUMENTATION.

Research In Motion Limited
295 Phillip Street
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